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Welcome

The TFG4000 Software Series is a set of business management software applications that
offer the robust functionality of an advanced management tool, yet tailored to meet the
needs and budget of your growing business. Even better — every application in the
TFG4000 Software Series is sold separately as a stand-alone product, which means you buy
only what you need to run your operation more efficiently. For example, companies that
only need to track and manage inventory are not forced to navigate through a multitude of
unnecessary screens, but rather access the specific application that they need to perform
their business operation. The added bonus of having every application in the TFG4000
Software Series is that each product recognizes the others and runs in harmony to provide
you the optimum benefit of business management software.

TFG4000 is an easy-to-learn, user-friendly system that requires only minimal keystrokes for
entering information. There are customizable dropdowns, font sizes, and screen colors
available within the applications, as well as powerful search capabilities and built-in help
features to help guide you through the system. With TFG4000, you have the ability to pull
up various summary screens, enter as little or as much data as you need, process a variety
of reports - all of which help you save both time and money, which will add directly to your
bottom line. For added convenience, TFG4000 also allows you to run the system in either
single or multi-user mode, whichever works best for your business. Other features include
optional security, as well as data import and export features, which save you the work of re-
keying information. In all, TFG4000™ is the smart source for business management. A
simple solution for a complex process.

System Requirements

Microsoft® Windows® 98, Windows NT® 4.0, Windows® 2000, Windows® ME, or Windows
XP®, with the latest Service Pack applied.

Pentium® class processor, 350mhz or greater.
90MB free disk space.
128MB of RAM (256MB recommended).

Network Interface Card configured to use TCP/IP if installing in multiple user mode (client /
server



Starting TFG4000

Perform the following steps to start TFG4000 in either Single or Multiple User Mode:

Single User
1. Open the “Start” menu, and then select the “Program” option.
2. Select “TFG4000 V1.4" from the program list.
3. Select “TFG4000" to start.

4. The TFG4000 “Welcome” screen is displayed with the “Tip of the Day”. You can
select “Close” to continue the start up process or select “Next Tip” to view more
tips. You can also choose not to have the “Tip of the Day” appear by selecting
the check box next to “Don’t show Tip of the Day at Startup” located on the
Welcome screen. Select the check box again at any time to reinstate the “Tip of
the Day” feature.

5. If you see a “User” and “Password” field on your screen, enter the User ID and
Password that your System Administrator provided you, and either press “Enter”
or click “Sign On”.

6. If your screen only displays “Welcome” without any other fields, then click the
plus sign (“+”) next to the application you want to perform in the “NavTree”.

7. Click on the screen you would like to use.



Multiple User (Not available in the Demo Version)
Server Startup

At installation, the server component is put in the Startup folder of the Program List.
It will automatically start at system start up. Perform this procedure only if
necessary.

1. Open the “Start” menu, and then select the “Program” option.
2. Select “TFG4000 V1.4” from the program list.
3. Select “TFG4000 Server V1.4" to start.

4. The TFG4000 “Welcome” screen is displayed with the “Tip of the Day”. You can
select “Close” to continue the start up process or select “Next Tip” to view more
tips. You can also choose not to have the “Tip of the Day” appear by selecting
the check box next to “Don’t show Tip of the Day at Startup” located on the
Welcome screen. Select the check box again at any time to reinstate the “Tip of
the Day” feature.

Client Startup

1. Open the “Start” menu, and then select the “Program” option.

2. Select “TFG4000 V1.4" from the program list.

3. Select “TFG4000 Client v1.4" to start.

4. The TFG4000 “Welcome” screen is displayed with the “Tip of the Day”. You can
select “Close” to continue the start up process or select “Next Tip” to view more
tips. You can also choose not to have the “Tip of the Day” appear by selecting
the check box next to “Don’t show Tip of the Day at Startup” located on the
Welcome screen. Select the check box again at any time to reinstate the “Tip of
the Day” feature.

5. If you see a “User” and “Password” field on your screen, enter the User ID and
Password that your System Administrator provided you, and either press “Enter”

or click “Sign On”.

6. If your screen only displays “Welcome” without any other fields, click the plus ign
(“+) next to the application you want to perform in the “NavTree”.

7. Click on the screen you would like to use.



Built-in Help
Help is available at the screen, field, and column level, as well as built-in tool tips.

Screen Level Help

To select screen level help, click “Help” on the “Menu” bar, and then select “Screen Help”.
Help for the screen is then displayed.

Screen Help
" About

Field Level Help

To select field level help, right click on the field, and then click “Help” from the pop-up.
Help for the selected field is then displayed. You may also press the F1 key to get field
help.

Cut

Copy
Paste

Column Level Help

To select column level help, right click on the column heading, and then click “Help” from
the pop-up. Help for the selected column is then displayed.

Column Help




Tip of the Day

Each time you start TFG4000, there is a “Tip of the Day” pop-up displayed that describes
some of the functionality that is available within the application. To close the “Tip of the
Day” pop-up, click the “Close” button. To view another tip, click the “Next Tip” button. This
feature can be turned off by clicking the box next to “Don’t Show Tip of the Day at Startup”
on the Welcome screen. A check mark will appear in the box indicating the “Tip of the Day”
should not be displayed during start up. To reinstate the “Tip of the Day” feature, click the
box and the check mark will disappear indicating the “Tip of the Day” should be displayed
during start up.

Example Only:
TIP OF THE DAY

The Purchase Order Mumber may be generated by the systermn. The system will generate
a unigque nuwmber for each new Purchasze Order. To use this option go to System
Administration, System Variables screen. Select Generate Purchase Order Number
and use the data dropdown to choose Yes. Bave your new gelection by clicking on the
Dave button. Restart the Server and all Clients.

[ &

Mext Tip

Tool Tips

Throughout TFG4000, there are embedded tool tips that help describe certain areas on the
screen. You simply roll your mouse (cursor) over the area in question, and a pop-up will
describe that specific area. The tool tip pop-up will remain visible for a few seconds, then it
will disappear automatically.

Example Only:

Item Definiion Item Information | [eem Summary | Price Summary |

Current kem
.R?:é Delete
ltem/Part: v| & & T |=
Description: ey £ ud =
P | [[dertication of the fternjPart |- L =
x
Wl4 v 3]
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Using TFG4000

You can navigate through the TFG4000 screens by using the “NavTree”, the “Goto Screen”
section of the “View Menu”, and the tabs on the top and bottom of the screen. For easy
use, the toolbar provides a variety of functions for you to choose from as you use the
TFG4000 applications. There are buttons located on the toolbar that allow you to perform
various functions from each screen, such as opening/displaying data, saving data, etc. The
“Menu” provides useful functions as well, such as printing reports, documentation, help, etc.

Sample Screen

= 1FGA0/ iemDetail

Actioft Bdit View 000 Documentafd :
#amm| - ~[[2FHd@ x >
TFG ¥ weitem Dafiniben | item information] item Dmmery | Frice Summery|
ot My Tree Curt e e
ﬁ%[:menwr Item/Part: #lBoORCASE, 487 e: [Azsembly Bl
¥ Bill of Materials Deserif 48" Wooden ) [Rach -]
» Inveniory Control Product Group: |active B
# J Process/Job Order
= B® Systern Administration
» User Control S—
b Location Control
» Crepdown Conirol Number: [pc-127 Sales: Sales Item ¥
¥ Syetem Virisbles Commadity: [Bookcase ttem Level:  [Aon
¥ Database Definitiors
¥ Serial Mumbers
» Utility Coritrot ——
* Welcome _
Gross: DiscountPercent: "
Discount: | ttem Cost: 20.000
Net:
Message:  [NextRecord Loaded
s ltem Defiritin Bl ONgatieials Invertory |

11



Menus

Each screen in TFG4000 has various menus available for working with your data. The
following describes the purpose of each menu and special features.

Action

This menu is for printing screens and for exiting TFG4000. It contains the following menu
items:

Print Prints the entire screen in either portrait or landscape
mode.
Print Text Prints only the text currently displayed on the screen in

either portrait or landscape mode.
Exit Terminates the TFG4000 session.
Edit

This menu is for performing cut, copy, and paste operations on data. It contains the
following menu items:

Cut When you highlight data and use this function, the data
is removed from the screen and is available in a
clipboard for pasting. Holding the “Ctrl” key and
pressing the “X” key will perform the same operation.

Copy When you highlight data and use this function, the data
is copied into a clipboard and is available for pasting.
Holding the “Ctrl” key and pressing the “C” key will
perform the same operation.

Paste When you position your cursor in a field and use this
function, data you have previously put into the clipboard
using the “Cut” or “Copy” operation will be pasted after
your cursor. Holding the “Ctrl” key and pressing the “V”
key will perform the same operation.

Note: If your keyboard is in “insert mode” the data will not overlay data that

follows, but if it is not in “insert mode” it will. Press the Insert key on your
keyboard to change your insert mode to whichever way you prefer.
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View

This menu allows you to change the way the TFG4000 screens are presented and how you
navigate the screens. It contains the following menu items:

Set Font Size

Hide Calendar Buttons

Flip Tree Position

Hide Navigation Tree

GoTo Screen

Reports

You can choose a font size from 10 to 18. With larger
font sizes you may have to scroll to see the entire
screen.

Toggles whether or not a Calendar button is displayed
next to the date fields.

Changes the position of the “NavTree” to either the left
or the right side of the screen.

Hides the “NavTree” from the screen. Click it a second
time to display the “NavTree” on the screen.

Note: The dark arrows in the bar between the NavTree”
and the main screen perform the same function.

Displays the “NavTree” in menu format. You can use
this method to navigate the screens at any time but it is
particularly useful if you hide the “NavTree”.

View Documenta

Set Font Size 4
Hide Calendar Buttons
Flip Tree Position

Hide MNavigation Tree

Goto Screen > Item Definition

Process/Job Order »  Bill of Materials
System Administration *  Inventory Control

This menu is only available if there are reports available for the screen you are on. There
will be various menu items depending on the screen.

Documentation

This menu lets you select the TFG4000 manuals for viewing and printing.

Help

This menu provides help about the screen you are on and information about TFG4000. It

contains the following menu items:

Screen Help

About

Displays information about the screen you are on.

Displays information about TFG4000.

13



Buttons & Icons

Each screen in TFG4000 has various buttons available for working with your data. The
following describes the purpose of each button and special features. It also explains other
icons you may see on the screens.

Toolbar Buttons < | & B | » o

|4 [FHE x « » &

Use the following buttons to perform TFG4000 application tasks. The buttons displayed
change with the screen you are working with.

Previous screens ¢

Use this button to return to your previous screen. You can go back up to ten screens.
Cutting, copying and pasting text| # & &

You can use “Cut” and “Paste” to move selected text. You can use “Copy” and “Paste” to
copy selected text and paste the copy in another place. “Cut”, “Copy”, and “Paste” can also
be selected from the “Edit” menu.

Working with data

You can erase, open, save, add, delete, get previous or next, copy, print, and refresh data
by using these buttons:

& Erase This button clears data from the screen. It does not
update any data; it merely clears the data away to make
it easier for you to enter something else. It is
particularly useful for resetting summary screens for a
new search and it may be required when adding new
entries on some screens.

S Open (Display) This button retrieves data that has been previously
saved for viewing and/or modifying. The Enter key
executes this button by default.

H save This button stores new data and modified data. If you
enter new data or change existing data and do not click
this button, the system prompts you to do so.

@ Cancel This button reduces any remaining quantities to zero
and changes statuses to “Cancelled”.

X pelete This button deletes previously saved data. On screens
indicated as “definition” screens, the delete button
deletes related data in addition to the data currently
displayed. On all other screens only the data displayed is
deleted.

4 Previous This button retrieves data that alphabetically precedes
the currently displayed data.

14



P Next

Ez Copy

= Print

%}’ Build

3 Refresh

Screen Buttons

This button retrieves data that alphabetically follows the
currently displayed data.

This button copies data from one place to another. On
screens indicated as “definition” screens, it copies

related data in addition to the data currently displayed.
On all other screens, only the data displayed is copied.

This button sends your document to the printer to be
printed.

This button extracts eligible data from one place to
create a new definition in another place. For example, it
can extract customer order data to build a new invoice.

This button rebuilds the data on the screen.

Throughout the screens are buttons that perform functions.

#% search

B Calendar

¥ Dropdown

Table Buttons
Throughout the tables are buttons

Bl GoTo/Selection

This button is for finding data you have already entered.
When you click this button a search box pops up.

This button provides a pop-up calendar for selecting
dates. You can choose the month and the year, and
then double-click on the date you desire. Click “Today”
to re-position the calendar on the current date. Click
“Cancel” if you decide not to select a date. Dates can be
entered without using the “Calendar” button if desired.
Manually entered dates are verified so a pop-up appears
prompting you to correct a date if it is invalid.

This button provides a “dropdown” list of pre-defined
values from various fields that have this button next to
it. If you click on one of the values from the dropdown
list, that value will appear in the adjacent field.

that perform functions.

This button is for either transferring to another screen or
selecting data. When you right-click on this button, it
displays a menu of related screens and/or a menu of
selection activities. To transfer to another screen, click
on the screen you desire and that screen is displayed
with the appropriate keys already filled in. To select
data, such as a component or inventory location, click
the action you want.

Goto Item Definition

Goto Bill of Materials Definition

15



5] Properties

= Add Rows

¢ Scroll to the Left
> Scroll to the Right
“« Scroll Up

¥ Scroll Down

x® Scroll Bottom
& Scroll Top

W Scroll Left

M Scroll Right

Information lcons

This button is located at the lower left corner of each
table. It allows you to edit the layout of the table. You
can use this button to hide or display columns in the
table and to restore the original table layout.

This button appears in the lower right corner of
modifiable tables so that you can put more empty rows
on the screen for adding data to the table. If you are
trying to enter another row in a table and there are not
any blank rows to use, click the “Add Rows” button.
This button allows you to scroll to the left of the table.
This button allows you to scroll to the right of the table.
This button allows you to scroll up the table.

This button allows you to scroll down the table.

This button allows you to scroll to the very bottom of the
table.

This button allows you to scroll to the very top of the
table.

This button allows you to scroll to the very left of the
table.

This button allows you to scroll to the very right of the
table.

Icons on the screen show properties about the field.

™ Numeric

7 Key

v Required

This icon in the upper left corner of a field indicates that
the field is for a numeric value. You are able to enter
only numbers, commas, and decimals in fields
containing this icon.

This icon to the left of a field indicates that the field is a
key field and is required for this screen.

If you try to display or save data without entering a

required field, this checkmark icon is displayed next to
the missing field.

16



Field Colors

The fields on the screens and in screen tables have three different colors that have
functional significance.

Gray A gray field is display only, no entry allowed or necessary
White A white field is open for entering data
Yellow A yellow field indicates where the cursor is currently positioned

Changing Screen Table Properties

Tables that appear on screens can be modified. The columns can be re-sized, re-positioned,
hidden, and un-hidden.

To re-size a column move your cursor over the column heading you want to re-size and
move to the right until you see an arrow with two heads. Click, then still holding the mouse
button down, move the cursor to the right until the column is as wide as you want or to the
left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse down,
move the column to the where you want it and release the mouse. Some columns are key
columns and will not remain where you re-position them.

Note: Re-sizing and re-positioning remain in effect for the duration of the current session.
The default sizing and positioning is restored when TFG4000 is restarted.

To hide or unhide a column click the Properties button = located in the lower left corner of
the table. A red check mark next to the column name indicates the column will be
displayed. If there is not red check mark next to the column name it will not be displayed in
the table. There may be multiple tabs for the table, so you must click on the tab that
contains the column(s) you want. To save the changes you have made, click the “OK”
button. To discard the changes you have made, click the “Cancel” button. To reset the
properties back to the default properties, click the “Restore Default Visibility” button.
Another pop-up will appear asking the range you wish to restore. Use the dropdown
provided to select either “All Tabs”, which will restore the defaults for the entire table, or
“Currently Displayed Tab Only”, which will restore the default properties only for the portion
of the table indicated by the tab you are viewing. Once you have made your selection click
“OK” or “Cancel”. That pop-up will disappear and the column visibility properties are reset
as requested or the reset action is cancelled. Then you may click either “OK” or “Cancel” to
save or discard the property changes.

Note: Property changes remain in effect even after TFG4000 is restarted.

17



Performing Searches

There are two types of searches in TFG4000 that are similar in appearance, however they
have different functionality. The first is a “Search” associated with a field on the screen.
The second is a “Search Pop-up” which is found on tables. One of the differences between
the two is that a “Search Pop-up” can load multiple table rows to the screen at one time but
a “Search” will not. Another difference is that “Search” screen results can be printed but
“Search Pop-up” results cannot.

Search Screen (Fields)

Below is an example of a search screen that may be used to locate information already
entered into the system, and/or to automatically populate the fields on the screen that you
are currently viewing or editing. When search results are displayed you can move the
columns into different places on the search screen so that the values can be viewed in
positions different from the default layout. Click the heading of the column you wish to
move then drag and drop it into the desired position. Resize columns by moving the cursor
over the heading until you see an arrow with two heads. Click, and with the mouse button
still down, move the cursor right or left until the column is the desired width. The default
layout is restored when the “Search” button is pressed and when you exit the search. In
addition, you also have the option to retain search parameters by checking the box located
next to “Retain Search Parameters”. This option allows you to save the search parameters
you used for future searches.

Example Only:

= Search gl
Search for item Numbers
Daouble-Click Search Results to Load Data to Screen
Search Criteria
Max Rows To Display: 30 I~ Retain These Search Parameters
Find Item MNumbers [starting with |[sockcase

S concel | et |

ftemiPart Description Type Unit of Measure
BOOKCASE, 48" 45" Wooden Bookcase Assembly Each
BOOKCASE, 60" B0 Wooden Bookcase Assembly Each
BOOKCASE, 84" &4" Wooden Bookcase Assembly Each

3 records found

18



Using the Search Screen

1.

2.

5.

6.

Click the Search button #4 located directly next to the field you want to search.

Enter the maximum number of rows of data you want to display in your results.
The default is “30”.

Select one of the search choices using the dropdown. The default is “starting
with”.

Enter all or part of the value you want to search with. You may leave the search
field blank to return all applicable records in the database. If there is a value in
the screen field you are searching on, it will be copied to the search field. You
can change the search field value on the “Search” screen.

Click the Search button ¢,

Double click on the row you desire to load the information to the main screen.

Modifying the View of the Search Results

To modify the view of the search results, do the following:

1.

To re-size a column move your cursor over the column heading you want to re-
size and move to the right until you see an arrow with two heads. Click, then still
holding the mouse button down, move the cursor to the right until the column is
as wide as you want or to the left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse
down, move the column to the where you want it and release the mouse. Some
columns are key columns and will not remain where you re-position them.

To re-size the window move your cursor over the edges of the window until you
see an arrow with two heads. Click, and then still holding the mouse button
down, move the cursor to increase or decrease the size of the window.

Printing the Search Results

To print the search results, use these steps:

1.

2.

Click the Print button =1 on the “Search” screen.

Type or select the appropriate formatting options in the dialog box and then click
“OK” to print the report.
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Search Pop-Up Screen (Tables)

Below is an example of a search pop-up screen that may be used to populate columns in the
table on the screen that you are currently viewing or editing. When search results are
displayed you can move the columns into different places on the search pop-up screen so
that the values can be viewed in positions different from the default layout. Click the
heading of the column you wish to move then drag and drop it into the desired position.
Resize columns by moving the cursor over the heading until you see an arrow with two
heads. Click, and with the mouse button still down, move the cursor right or left until the
column is the desired width. The default layout is restored when the “Do Search” button is
pressed and when you exit the search pop-up.

Example Only:

Search Criteria

Max Rows To Display: 30
Find values [starting with | |Bookease

Cancel

ftemPart Description Unit of Measure Type
BOCHCASE, 458" 45" Wooden Bookcase Each Aszembly
BOCHCASE, 60" G0" Wooden Bookcase Each Aszzembly
BOCOKCASE, 84" 24" Wooden Bookcaze Each Aszzembly

Select Al ‘ cancel ‘

3 records found
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Using the Search Pop-Up Screen

1.

2.

Right Click the GoTo/Selection button Bl in the row you want to search.

Enter the maximum number of rows of data you want to display in your results.
The default is “30”.

Select one of the search choices using the dropdown. The default is “starting
with”.

Enter all or part of the value you want to search with. You may leave the search
field blank to return all applicable records in the database.

Click the “Do Search” button.

To select just one entry, double-click on it to populate the fields on your screen.
To select more than one entry, hold down the “Control” key while you click on the
other selections with your mouse, then click “Load to Screen” to populate the

information.

To load all of the entries to the screen table, click the “Select All” button and then
click the “Load to Screen” button.

Modifying the View of the Search Results

To modify the view of the search results, do the following:

1.

To re-size a column move your cursor over the column heading you want to re-
size and move to the right until you see an arrow with two heads. Click, then still
holding the mouse button down, move the cursor to the right until the column is
as wide as you want or to the left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse
down, move the column to the where you want it and release the mouse. Some
columns are key columns and will not remain where you re-position them.

To re-size the window move your cursor over the edges of the window until you
see an arrow with two heads. Click, and then still holding the mouse button
down, move the cursor to increase or decrease the size of the window.

Printing the Search Results

To print the search results, use these steps:

1.

2.

Click the Print button =1 on the “Search” screen.

Type or select the appropriate formatting options in the dialog box and then click
“OK” to print the report.
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Working with Reports

You can view, modify, and print reports by using the “Reports” menu located just above the
toolbar. If “Reports” is faded gray, then there are no reports available for that screen.

To view a report, follow these steps:

1. Click on “Reports” above the toolbar. A menu will drop down indicating which
reports can be generated from that screen. Click on the report name that you
want.

2. A status window will appear showing that the system is generating the report.

3. You will then see your report displayed on the screen.

To modify and/or print a report, follow these steps:

1. Click on “Reports” above the toolbar. A menu will drop down indicating which
reports can be generated from that screen. Click on the report name that you
want.

2. A status window will appear showing that the system is generating the report.

3. You will then see your report displayed on the screen with this toolbar at the

top:
Pririting Optionz Page Setup | Prirt | Prewvicw | Excel | Rewvert | Helg |

Printing Options Allows you to set the Page Number Prefix, number of
pages wide, and the Repeat Section Header/Footer
settings. Adjust the settings to your specifications and
then click “OK”.

Page Setup Allows you to adjust page settings. Once finished
adjusting the settings, click “OK”.

Print Allows you to select printer settings and print your
report. Once finished with settings, click “OK” to print
the report.

Preview Allows you to preview your report layout before you
actually print. Once finished previewing, click “Close”.

Excel Allows you to save your report as an Excel document.
Once finished naming and specifying where to save your
report, click “Save”.

Revert Allows you to discard all layout changes and revert to
default settings. Simply click either “Yes”, or “No”.

Help Shows the Report Layout Instruction screen.
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In some reports the selection criteria can be changed in the report window. Adjust the
selection criteria as desired, and then click the “Refresh” button to reload the data. When
you exit the report you will be asked if you want to update the screen with the refreshed
data from the report. Click “Yes” to update the screen or “No” to leave the screen as it was
when you started the report.

Report layouts can be modified. The columns can be re-sized, hidden, and un-hidden.

To re-size a column move your cursor over the column heading you want to re-size and
move to the right until you see an arrow with two heads. Click, then still holding the mouse
button down, move the cursor to the right until the column is as wide as you want or to the
left until the column is as small as you want.

To hide or unhide a column right click in the report area, then select the “Column Visibility”
tab. A red check mark next to the column name indicates the column will be displayed. If
there is not red check mark next to the column name it will not be displayed in the report.
To save the changes you have made, click the “OK” button. To discard the changes you
have made, click the “Cancel” button. To reset the properties back to the default properties,
click the “Revert” button located on the report toolbar. A dialog box will appear asking if you
want to discard changes and revert back to default settings. Click either “Yes” to restore the
defaults or “No” to keep the changes.

Note: Report layout changes remain in effect even after TFG4000 is restarted.
Working with Summary Screens and Summary Reports

TFG4000 has many summary screens and reports available for locating data, listing data,
and summarizing data. Each summary screen and report has various fields for search
criteria that are used in combination with one another. The search criteria fields can use
wildcards and other sophisticated SQL search techniques. For more information about
wildcard characters that can be used for advanced searching, refer to the following Microsoft
website:

http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/off2000/html/acconWildcardCharactersS.asp

Due to differences between Access and ANSI wildcard characters, when reading this website
and using wildcards in TFG4000, substitute as follows:

%o for *
__for?
# is not used

Also note that these wildcards cannot be used in searches.
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Item Definition

What is an Item?

An item can be something having material existence like a piece of wood or a bookcase or a
hammer. It can be a service like mowing a lawn or catering a party. It can even be
something more abstract like labor. With TFG4000 you have the capability of defining each
item uniquely. Unique identification of an item is possible by the use of both alphabetic and
numeric characters which can be combined into discrete units.

TFG4000 allows you to create these item definitions by the use of fields that describe each
item.

Item Definition Screens

“Item Definition” consists of four tabbed screens that are used to enter and maintain item
data. Each screen is used for specific purposes to aid in the entry and maintenance of items.

Item Definition

This screen allows you to enter and maintain data for an individual item.

Item Information

This screen allows you to enter text that you wish to maintain concerning an item. For
example, you could enter text information for an item that is too long or detailed for the
“Description” field. You can also attach references to external documents, including
electronic documents such as spreadsheets, drawings and word processor documents,
references to physical documents such as books and maps, and references to URL’s for web
sites.

Item Summary

This screen is used to display “Item/Part” entries for all items. The two tabs at the top of
the table allow you to display the fields located on the “ltem Definition” screen. Each row in
the table represents one item with its associated data.

Price Summary

This screen can be used to display and maintain pricing data for items that have pricing
data. Items without pricing data are not displayed. The two tabs at the top of the table
allow you to display the fields located on the “Item Definition” screen. Each row in the table
represents one item with its associated pricing data.

Labels

The label screen allows you to print item labels based on the selection criteria used.
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Item Definition Screens Explained

Item Definition Screen

This screen allows you to enter and maintain data for an individual item. An item can be
defined as a service, raw material, assembly, etc.

Current Item Group

Field

Item/Part

Type

Description

Unit of Measure

Revision Level

Status
Current Data Group

Field

Product Group

Sales

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. A dropdown list of values is provided for
your convenience. You can use those values or define
your own using the "Dropdown Control" screen under
"System Administration"”. Some examples of types are:
"Assembly" something you build, "Service" for a service
you provide, "Tool" for something you use in your
operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. A
dropdown list of values is provided for your convenience.
You can use those values or define your own using the
"Dropdown Control" screen under "System
Administration”. Some examples of units of measure
are "Ounce", "Pound", and “Hour".

Most current revision level for this item. Informational
only.

Specifies whether the item or part is active or inactive.

Explanation

A user defined field for grouping items together. It can
be used to group items together so they can be located
based on their grouping.

Identifies whether or not the associated item is for sale.

Some items can be a part of a larger item and are not
for sale individually.
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Drawing Number

Item Level

Commodity

Price Data Group

Discount

Net

Discount Percent

Material Cost

All Other Cost

Inventory Cost

Stock Item

This can be an engineering or design drawing associated
with the item.

The level within a Bill of Materials where an item is used.
On the “ltem Definition” screen, this will be the lowest
level at which the item appears on any Bill of Materials.

A term that can be applied to groups of items that are
similar in some way. This field is normally used for
purchasing data; for example, different types of bird
seed stocked by a store.

Explanation

Basic price for an item before any discounts or
surcharges are applied.

Discount amount to be subtracted from the Gross price
to determine the Net price. If a value is entered in this
field, it overrides the percent amount entered in the
“Discount Percent” field if both are entered. If an
absolute discount amount is entered the “Discount
Percent” field will be set to zero.

Net price for an item after any discount is applied. This
value is calculated from the Gross amount and the
Discount amount, as Gross minus Discount, and is not
an input field.

Discount percentage applied to the Gross price to
determine the Net Price; for example, a gross price of
10.00 with a discount percent of 10 would result in a net
price of 9.00 (10.00 x 10% = 1.00; 10.00 - 1.00 =
9.00). If Discount Percent is zero and Discount has a
value other then zero, then the “Discount” field was
updated directly with an absolute amount.

The amount required to manufacture or purchase an
item.

The amount associated with this item that is not a
manufacturing or purchasing cost. This can be any
combination of costs such as processing cost, overhead,
etc.

The amount used to calculate the total on hand cost of
the item.

Indicates if the inventory for this item is controlled by

the system or not. Yes = inventory controlled item, No =
not inventory controlled item.
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Message Line

Field Explanation
Message Displays information about the current status of the
screen.

Accessing the Item Definition Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_Or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Item Definition”. The Item Definition screen is then displayed.

3. If there is an item or part number in the “ltem/Part” field, the item definition for
that item is displayed on the main screen.
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Using the Item Definition Screen

Use these procedures to erase the screen, display, update, add, delete, display the
previous, and display the next item/part.

Erasing the Screen

To erase the data from the screen click the Erase button & located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying an Existing Item

To display an item, perform the following steps:

1.

2.

3.
Updating
To update

1.

Enter an item or part number in the “ltem/Part” field.

Click the Open (Display) button & located on the toolbar or hit the Enter key.
The item or part number is displayed on the main screen.

—or-

Use one of the following Search buttons #4 to locate the item number you want:
a) Button next to the “Item/Part” field

b) Second button next to the “Description” field

¢) Second button next to the “Product Group” field

d) Button next to the “Type” field

e) Button next to the “Status” field

f) Second button next to the “Drawing Number” field

g) Second button next to the “Commodity” field

Double-click on the “Item/Part” you would like to display in the “Search” screen
table.

The item or part number is displayed on the main screen.
an Existing Item
an existing item or part, perform the following steps:

Display the item or part number you wish to change. See “Displaying an Existing
Item” above.

Change the desired information on the screen. You can enter data or use any of

the following Search buttons #4 to locate data to use:

a) First button next to the “Description” field to find a description among
descriptions you have already used

b) First button next to the “Product Group” field to find a product group from
among product groups you have already used

c) First button next to the “Drawing Number” field to find a drawing number
among the drawing numbers you have already used
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3.
Adding a
To add an

1.

2.

5.

Tip:

d) First button next to the “Commodity” field to find a commodity from among
commodities you have already used

When done, click the Save button I 1ocated on the toolbar.
New Item

item, perform the following steps:

Click the Erase button -# located on the toolbar to clear the screen.

Enter a new item or part number in the “ltem/Part” field. This number must be a
unique item or part number. The “ltem/Part” field is required.

Enter data in any of the other fields you desire, these fields are optional.

You can enter data or use any of the following Search buttons #4 to locate data to

use:

a) First button next to the “Description” field to find a description among
descriptions you have already used

b) First button next to the “Product Group” field to find a product group from
among product groups you have already used

c) First button next to the “Drawing Number” field to find a drawing number
among the drawing numbers you have already used

d) First button next to the “Commodity” field to find a commodity from among
commodities you have already used

When done, click the Save button = 1ocated on the toolbar.
_or_

Display an existing item or part number. See “Displaying an Existing Item”
above.

Change the item or part number in the “ltem/Part” field to a new value.
Change any of the other fields you desire, these fields are optional.

You can enter data or use any of the following Search buttons #4 to locate data to

use:

a) First button next to the “Description” field to find a description among
descriptions you have already used

b) First button next to the “Product Group” field to find a product group from
among product groups you have already used

c) First button next to the “Drawing Number” field to find a drawing number
among the drawing numbers you have already used

d) First button next to the “Commodity” field to find a commodity from among
commodities you have already used

When done, click the Save button = located on the toolbar.

The second procedure above can be used to copy an item or part to a new
item or part number.
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Deleting an Existing Item
To delete an existing item or part, perform the following steps:

1. Display the item or part number you wish to delete. See “Displaying an Existing
Item” above.

2. Click the Delete button X located on the toolbar.

3. Click the “Yes” button on the “Confirm Action” pop up message. If you do not
want to delete the item or part click “No” on the “Confirm Action” pop up
message.

Note: Once an item or part number is deleted, it can no longer be displayed or
updated.

Displaying the Previous Item

To display the item that precedes the item currently displayed, perform the following steps:
1. Click the Previous button 4 located on the toolbar.
2. The previous item or part number is displayed on the main screen.

Displaying the Next lItem

To display the item that follows the item currently displayed, perform the following steps:
1. Click the Next button ! located on the toolbar.
2. The next item or part number is displayed on the main screen.

Tip: You can use the Next button " as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .é, then
click the Next button F .
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Item Information Screen

This screen allows you to enter text that you wish to maintain concerning an item. For
example, you could enter text information for an item that is too long or detailed for the
“Description” field. You can also attach references to external documents, including
electronic documents such as spreadsheets, drawings and word processor documents,
references to physical documents such as books and maps, and references to URL’s for web
sites. You can right click and use the GoTo/Selection button & in the table to display an

electronic external document.

Current Item Group

Field

Item/Part

Description

Information Table
Column
Row

Info Type

Text Information

Delete

Reference Table
Column

Row

Reference Type

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Explanation

The line number of the row in the table.

A designation for the type of information stored. A
dropdown list of values is provided for your convenience.
You can use those values or define your own using the
"Dropdown Control” screen under "System
Administration™.

This is where you enter text information or view text
that has already been entered.

This is a checkbox to indicate you want to delete a text
record.

Explanation

The line number of the row in the table.

A designation for the type of reference stored. A
dropdown list of values is provided for your convenience.
You can use those values or define your own using the
"Dropdown Control" screen under "System
Administration".
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Reference

Delete

Message Line

Field

Message

Directory and file name for an electronic reference, URL
for a website, or description of where to find a physical
reference. An electronic reference can be a
spreadsheet, a word processor document, or a text file.
A physical reference can be the name of a book with the
page number.

This is a checkbox to indicate you want to delete a
reference record.

Explanation

Displays information about the current status of the
screen including error messages.

Accessing the Item Information Screen

1. Click the plus (“+") next to “Inventory” or double-click % “Inventory” in the

“NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.

2. Click “Item Definition”. The Item Definition screen is then displayed.

3. If there is an item or part number in the “Item/Part” field, the item definition for
that item is displayed on the main screen.

4. Click the “Item Information” tab at the top of the main screen.

5. If there is an item or part number in the “ltem/Part” field, the information text
types and references for that item are displayed on the main screen.
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Using the Item Information Screen

Use these procedures to display, update, add, delete, display the previous, and display the
next item information or references.

Displaying Existing Item Information and References
To display item information or references, perform the following steps:

1. Enter an item or part number in the “Item/Part” field and click the Open (Display)
button & located on the toolbar or hit the Enter key.

_Or_
Use the Search button # next to the “Item/Part” field, or the “Description” field
to select an item number and double-click on the “Item/Part” you would like to

display in the “Search” screen table.

2. The information text types and references for the item or part number are
displayed on the main screen.

3. To display information text, click the Goto/Selection button &l in the “Text
Information” column of the Information table for the row you want to display and
select “Edit Information Text” on the menu that appears. Use the scroll bar on
the right to display more rows if necessary.

4. The text will be displayed in a pop-up window.

5. The reference information is displayed in the Reference table. Use the scroll bar
on the right to display more rows if necessary.

6. To view electronic references, right click on the reference you would like to
display. Choose “Goto External Application” from the menu.

Updating Existing Item Information
To update existing item information, perform the following steps:

1. Display the item or part number you want to change. See “Displaying Existing
Item Information” above.

2. Click the Goto/Selection button &l in the “Text Information” column of the
Information table for the row you want to update and select “Edit Information
Text” on the menu that appears. Use the scroll bar on the right to display more
rows if necessary.

3. The text will be displayed in a pop-up window.

4. Change the desired information in the pop-up window and click “Ok” when done.

5. When you have finished editing all of the entries you wish to edit, click the Save
button I located on the toolbar.

Note: You can update Item Information and References at the same time.
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Updating Existing Item References

To update existing item references, perform the following steps:

1.

3.

Display the item or part number you want to change. See “Displaying Existing
Item Information” above.

Enter the new reference in the “Reference” column of the Reference table for the
row or rows you wish to update.

_or_
For an electronic reference, right click the reference you want to update. Choose

“Select External File”. A standard Windows file selection dialog is displayed.

Locate the directory that contains the file you want. Select the file you want and
click the “Open” button.

Once finished, click the Save button & |ocated on the toolbar.

Note: You can update Item Information and References at the same time.

Adding Item Information

To enter item information, perform the following steps:

1.

6.

7.

Display the item or part number you want to change. See “Displaying Existing
Item Information” above.

Click an empty row in the Text Type table. If there are no empty rows click the
Add Rows button E' in the lower right corner of the table.

Type the first letter of the text type you want (type the letter multiple times if
there is more than one type that begins with the same letter).

-0or-

Using the dropdown list, select the Text Type in the “Text Type” column of the
Text Type table.

Click the Goto/Selection button & in the “Text Information” column of the

Information table for the row you want and select “Edit Information Text” on the

menu that appears. Use the scroll bar on the right to display more rows if
necessary.

The text will be displayed in a pop-up window.
Enter the desired information in the pop-up window and click “Ok” when done.

Once finished, click the Save button E located on the toolbar.

Note: You can add Item Information and References at the same time.
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Adding Item References

To enter item references, perform the following steps:

1.

2.

5.

Display the item or part number you want to change. See “Displaying Existing
Item Information” above.
Click an empty row in the Reference table. If there are no empty rows click the

Add Rows button El in the lower right corner of the table.

Type the first letter of the reference type you want (type the letter multiple times
if there is more than one type that begins with the same letter).

-0or-

Using the dropdown list, select the Reference Type in the “Reference Type”
column of the Reference table.

Enter the reference in the “Reference” column.

_or_

For an electronic reference, right click the reference you want to update. Choose
“Select External File”. A standard Windows file selection dialog is displayed.

Locate the directory that contains the file you want. Select the file you want and
click the “Open” button.

Once finished, click the Save button = located on the toolbar.

Note: You can add Item Information and References at the same time.

Deleting Existing Item Information and References

To delete existing item information and references, perform the following steps:

1.

Display the item or part number that has the information text and/or reference
you want to delete. See “Displaying Existing Item Information” above.

To delete text information, click the checkbox [ in the “Delete” column of the
Information table for the row you want to delete. You may select more then one
row to be deleted at one time. Click the checkbox [ again to remove the
deletion flag.

To delete reference information, click the checkbox " in the “Delete” column of
the Reference table for the row you want to delete. You may select more then
one row to be deleted at one time. Click the checkbox I\ again to remove the
deletion flag.

4. Once finished, click the Save button = located on the toolbar.

Note: Once item information is deleted, it can no longer be displayed or updated.
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Displaying the Previous Existing Item Information and References

To display the item information and references that precede the item information currently
displayed, perform the following steps:

1. Click the Previous button * located on the toolbar.
2. The previous item'’s information and references are displayed on the main screen.
Displaying the Next Existing Item Information and References

To display the item information and references that follow the item information currently
displayed, perform the following steps:

1. Click the Next button P located on the toolbar.
2. The next item’s information and references are displayed on the main screen.

Tip: You can use the Next button " as a convenient way to locate the first record
in the database. Start by blanking out the “lItem/Part” field, then click the

Next button * .
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Item Summary Screen

This screen is used to display “ltem/Part” entries for all items. The two tabs at the top of
the table allow you to display the fields located on the “lItem Definition” screen. Each row in
the table represents one item with its associated data.

Selection Criteria Group

Field

Item/Part

Type

Description

Sales

Number of Rows to Display

Commodity

Product Group

Summary Table (Primary tab)

Column

Row

ltem/Part

Description

Explanation

This field is for entering all or part of an Item Number to
select the items to be displayed. Leave this field blank
to select all items.

This field is for choosing the type of items to be
displayed. Leave this field blank to select all item types.
A dropdown list of values is provided for your
convenience.

This field is for entering all or part of an Item
Description to select the items to be displayed. Leave
this field blank to select all descriptions.

This field is for choosing if you want sales items or non-
sales items to be displayed. Leave this field blank to
select all sales types. A dropdown list of values is
provided for your convenience.

Controls the number of database rows to retrieve during
the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.

Use the selection criteria to help control the number of
rows retrieved.

This field is for entering all or part of a commodity to
select the items to be displayed. Leave this field blank
to select all commodities.

This field is for entering all or part of a product group to

select the items to be displayed. Leave this field blank
to select all product groups.

Explanation

The line number of the row in the table.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Contains information describing the item. This
description can be as short as an abbreviation or a long
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Type

Unit of Measure

Sales Item

Summary Table (Secondary tab)

Column
Row

Item/Part

Product Group

Commodity

Drawing

Summary Table (Cost tab)

Column
Row

Item/Part

Material Cost

Other Cost

detailed description of the item.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

Identifies whether or not the associated item is for sale.
Some items can be a part of a larger item and are not
for sale individually.

Explanation

The line number of the row in the table.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

A user defined field for grouping items together. It can
be used to group items together so they can be located
based on their grouping.

A term that can be applied to groups of items that are
similar in some way. This field is normally used for
purchasing data; for example, different types of bird
seed stocked by a store.

This can be an engineering or design drawing associated
with the item.

Explanation

The line number of the row in the table.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The amount required to manufacture or purchase an
item.

The amount associated with this item that is not a
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manufacturing or purchasing cost. This can be any
combination of costs such as processing cost, overhead,

etc.

Inventory Cost The amount used to calculate the total on hand cost of
the item.

On Hand Quantity The number of units in inventory.

On Hand Cost The on hand quantity times the inventory cost.

Message Line

Field Explanation

Message Displays information about the current status of the

screen including error messages.

Accessing the Item Summary Screen

1.

Click the plus (“+) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_Or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
Click “Item Definition”. The Item Definition screen is then displayed.

If there is an item or part number in the “ltem/Part” field, the item definition for
that item is displayed on the main screen.

Click the “Item Summary” tab at the top of the main screen.
If there is a complete or partial Item/Part number in the “lItem/Part” field, then

those items matching the selection are displayed in the Summary table on the
main screen.

39



Using the Item Summary Screen

Displaying Item Summaries

To display an item summary, perform the following steps:

1.

Enter all or part of an item or part number in the “Item/Part” field. You can leave
the “Item/Part” field blank to select all items.

Enter or select values in the other selection criteria fields as desired.
Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.

The item summary results are displayed in the Summary table on the main
screen.

If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change the selection criteria.

_o r_

Use the Search button # next to the “Item/Part” field or the “Description” field to
select an item number.

Double-click on the “Item/Part” you would like to display in the “Search” screen
table.

The item summary results are displayed in the Summary table on the main
screen.

Enter or select values in the other selection criteria fields as desired.
Click the Open (Display) button & located on the toolbar or hit the Enter key.

The new item summary results are displayed in the Summary table on the main
screen.

If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change the selection criteria.

Item Summary Reports

The Item Summary screen has the following report available:

Item Summary List
Basically the same information displayed on the Item Summary screen.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Labels Screen

This screen is for printing item labels.

Selection Criteria

Field

Item/Part

Type

Description

Sales

Commodity

Product Group

Number of Rows to Display

Label Parameters

Field

Label Format

Label Form

Label Font

Explanation

This field is for entering all or part of an Item Number to
select the items to be printed on the labels. Leave this
field blank to select all items.

This field is for choosing the type of items to be printed
on the labels. Leave this field blank to select all item
types. A dropdown list of values is provided for your
convenience.

This field is for entering all or part of an Item
Description to select the items to be printed on the
labels. Leave this field blank to select all descriptions.

This field is for choosing if you want sales items or non-
sales items to be printed on the labels. Leave this field

blank to select all sales types. A dropdown list of values
is provided for your convenience.

This field is for entering all or part of a commodity to
select the items to be printed on the labels. Leave this
field blank to select all commodities.

This field is for entering all or part of a product group to
select the items to be printed on the labels. Leave this
field blank to select all product groups.

Controls the number of database rows to retrieve during
the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.

Use the selection criteria to help control the number of
rows retrieved.

Explanation

Field that indicates what type of label you want to print.
The label format defines what data will appear on the
labels. A search button is provided so you can select
from the available types.

Field that indicates the label form (e.g. Avery 5168) you
want to use when you print the labels. A search button
is provided so you can select from the available types.

Size of the font to be used when the label is printed. The
default is based on the label format.
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A dropdown is provided to indicate if you want the font
to be Bold or Not Bold.

Print Landscape Checkbox to indicate if you want the labels printed in
landscape or portrait orientation.

Center Text Vertically

Within Each Label Should the label's text be centered vertically on the
label, or should the first line of text begin at the top
edge of the label? When this option is selected the
label’s text will be centered vertically on the label.

Allow me to Indicate Specific

Labels on which Nothing should

be Printed
Check this box so you can get a map of the label sheet
when you click the Create Labels button. Then you can
indicate which labels on a sheet of labels should be
bypassed during printing. You can mark as many pages
as necessary. This is for using sheets of labels that may
have labels that are missing or unusable.

Message Line

Field Explanation
Message Displays information about the current status of the

screen including error messages.

Accessing the Labels Screen

1. Click the plus (“+”) next to “Inventory” or double-click 2 “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Item Definition”. The Item Definition screen is then displayed.

3. If there is an item or part number in the “lItem/Part” field, the item definition for
that item is displayed on the main screen.

4. Click the “Labels” tab at the top of the main screen.
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Using the Labels Screen

Use these procedures to print item labels.

Printing Item Labels

To print item labels, perform the following steps:

1.

2.

Enter selection criteria to determine which items will be printed.

Use the GoTo/Selection button ] next to “Label Format” to select the type of
label you want to print (label format defines the data that will appear on the
label). You can use the Label Format screen (under System Administration then
Label Definition) to define a label format.

Use the GoTo/Selection button &l next to “Label Form” to select the type of form
you want to print the labels on e.g. Avery 5168. You can use the Label Definition
screen under System Administration to define a label form.

Change formatting options as desired. Click the “Advanced Options” button @
located on the toolbar to adjust margins, etc.

Click the Print button € located on the toolbar when you are ready to print the
labels.

If you clicked the checkbox next to “Allow me to Indicate Specific Labels on which
Nothing should be Printed”, you will see a graphic representation of a sheet of
labels. Click the label(s) you want to skip. They will have “Don’t Use” on them.
Click again to allow them to be used. Click “Next Page” to mark additional sheets
as necessary. Click “Ok” when you are ready to start printing.
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Price Summary Screen

This screen can be used to display and maintain pricing data for items. Only items with non-
zero gross price are displayed. The two tabs at the top of the table allow you to display the
fields located on the “lItem Definition” screen. Each row in the table represents one item

with its associated pricing data.

Selection Criteria Group

Field

Item/Part

Type

Description

Sales

Number of Rows to Display

Commodity

Discount Percent

Product Group

Summary Table (Primary tab)

Column

Explanation

This field is for entering all or part of an Item Number to
select the items to be displayed. Leave this field blank
to select all items.

This field is for choosing the type of items to be
displayed. Leave this field blank to select all item types.
A dropdown list of values is provided for your
convenience.

This field is for entering all or part of an Item
Description to select the items to be displayed. Leave
this field blank to select all descriptions.

This field is for choosing if you want sales items or non
sales items to be displayed. Leave this field blank to
select all sales types. A dropdown list of values is
provided for your convenience.

Controls the number of database rows to retrieve during
the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.

Use the selection criteria to help control the number of
rows retrieved.

This field is for entering all or part of a commodity to
select the items to be displayed. Leave this field blank
to select all commodities.

This field is for mass update of discount percentages. It
is used to update all rows that are displayed in the
Summary table below. When the Save button H is
clicked the percentage in this field overrides any
Discount Percent and Discount Amounts that were
updated in the Table rows below.

This field is for entering all or part of a product group to
select the items to be displayed. Leave this field blank
to select all product groups.

Explanation
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Row

Item/Part

Gross Price

Discount Percent

Discount Amount

Net Price

Commodity

Product Group

Summary Table (Secondary tab)

Column

Row

Item/Part

Description

Type

The line number of the row in the table.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Basic price for an item before any discounts or
surcharges are applied.

Discount percentage applied to the Gross price to
determine the Net Price; for example, a gross price of
10.00 with a discount percent of 10 would result in a net
price of 9.00 (10.00 x 10% = 1.00; 10.00 - 1.00 =
9.00). If Discount Percent is zero and Discount has a
value other then zero, then the “Discount” field was
updated directly with an absolute amount.

Discount amount to be subtracted from the Gross price
to determine the Net price. If a value is entered in this
field, it overrides the percent amount entered in the
“Discount Percent” field if both are entered. If an
absolute discount amount is entered the “Discount
Percent” field will be set to zero.

Net price for an item after any discount is applied. This
value is calculated from the Gross amount and the
Discount amount, as Gross minus Discount, and is not
an input field.

A term that can be applied to groups of items that are
similar in some way. This field is normally used for
purchasing data; for example, different types of bird
seed stocked by a store.

A user defined field for grouping items together. It can

be used to group items together so they can be located
based on their grouping.

Explanation

The line number of the row in the table.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

The type helps further define an item by giving it a
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Status

Unit of Measure

Sales Item

Message Line

classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Specifies whether the item or part is active or inactive.
Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound" and
“Hour".

Identifies whether or not the associated item is for sale.

Some items can be a part of a larger item and are not
for sale individually.

Explanation

Displays information about the current status of the
screen including error messages.

Accessing the Price Summary Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the

“NavTree”.

_o r_

Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.

2. Click “Item Definition”. The Item Definition screen is then displayed.

3. If there is an item or part number in the “ltem/Part” field, the item definition for
that item is displayed on the main screen.

4. Click the “Price Summary” tab at the top of the main screen.

5. If there is a complete or partial Item/Part number in the “lItem/Part” field, then
those items matching the selection are displayed in the Summary table on the

main screen.
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Using the Price Summary Screen
Displaying Price Summaries
To display a price summary, perform the following steps:

1. Enter all or part of an item or part number in the “Item/Part” field. You can leave
the “Item/Part” field blank to select all items.

2. Enter or select values in the other selection criteria fields as desired.
3. Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.

4. The price summary results are displayed in the Summary table on the main
screen.

5. If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change your selection criteria.

_0 r_

1. Use the Search button # next to the “Item/Part” field or the “Description” to
select an item number.

2. Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.

3. The price summary results are displayed in the Summary table on the main
screen.

4. Enter or select values in the other selection criteria fields as desired.
5. Click the Open (Display) button & located on the toolbar or hit the Enter key.

6. The new price summary results are displayed in the Summary table on the main
screen.

7. If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change your selection criteria. Also verify that
the item has a price defined on the Item Definition screen.

Selectively Updating Price Date

To update price data selectively, perform the following steps:

1. Display the items or part numbers you want to change. See “Displaying Price
Summaries” above.

2. Change Gross Price and Discount Percent or Discount Amount as desired.

3. Once finished, click the Save button = located on the toolbar.
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Mass Updating Discount Percent

To execute a mass update of discount percent data, perform the following steps:

1.

Display the items or part numbers you want to change. See “Displaying Price
Summaries” above.

Enter the discount percentage you want in the “Discount Percent” field in the
Selection Criteria area of the screen.

Once finished, click the Save button E 1ocated on the toolbar.

All of the items displayed in step 1 will be updated with the new Discount Percent
including recalculation of the Discount Amount and Net Price.

Note: Any changes made directly in the table will be overridden by the discount

percent mass update.

Price Summary Reports

The Price Summary screen has the following report available:

Item Price Summary
Basically the same information displayed on the Price Summary screen.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Bill of Materials

What is a Bill of Materials?

A Bill of Materials (BOM) is a series of individual items that are grouped together to create a
larger item defined by a specific identifier. It is a list of what is required to produce a
physical product or perform a service. For a physical product it can be as simple as a list of
the ingredients for a cake or as complex as the list of parts needed to build a computer. For
a service it can be as simple as the supplies and services necessary to cater a birthday party
or as complex as the tools, supplies, and services needed to maintain an office building.

Bills of material are connected by ‘links.” Each component is stand-alone and can be used in

multiple places. Pointers or links are used to connect items to create a bill of materials.
Essentially, it means you only have to maintain a component once in the database.
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Defining a Multi-Level Bill of Materials (BOM)

The following describes the steps to define a BOM that has several levels of components.

Physical Product

For a physical product, an assembly is a collection of parts and/or subassemblies that are
put together. A subassembly is an assembly that is used at a higher level to make up
another assembly. Each assembly and subassembly is given a unique identifier.

Subassemblies and parts are generally categorized together as components, and may be
produced in the same place as the finished product or purchased from vendors.

A BOM is a listing of all components that go into an assembled product showing the quantity
of each required to make one assembly.

The following figure shows a multi-level product tree with subassemblies Z and Q. Q is

assembled from Items 1 and 4, and Z is assembled from subassembly Q and Item 2.
Product X is the final assembly of subassembly Z and Items 3 and 5.

Multi-Level Product Tree

X Level 0
Z @ Gb Level 1
Q Level 2

|
@ @ Level 3

In this example we could be building a bird house where Q is the roof assembly composed
of Item 1 (wood) and Item 2 (glue). Z is the house assembly that contains the roof
assembly Q and Item 2 (wood for bottom and sides). Finally, Z is used on the finished bird
house with item 3 (decorative trim) and Item 5 (birdhouse stand). Perhaps Item 5 is an
assembly that is purchased already assembled so it would not have a bill of materials like Q
and Z that we assemble ourselves.
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Service

For a service, an assembly is a collection of services, materials, and/or subassemblies that
are needed to complete the service. A subassembly is an assembly that is used at a higher
level to make up another assembly. Each assembly and subassembly is given a unique
identifier.

Subassemblies and parts are generally categorized together as components.

A BOM is a listing of all components that go into a service showing the quantity of each
required to complete the service.

The following figure shows a multi-level service tree with subassemblies Z and Q. Q is a

subassembly that uses Items 1 and 4, and Z consists of Q and Item 2. Service X is the final
assembly consisting of Z and Items 3 and 5.

Multi-Level Serive Tree

X Level 0

z @ é Level 1

\\2 Q Level 2
|

@ Level 3

An example of this could be in a catering business where Q is a set of utensils containing
Item 1, which is a plastic fork and Item 4 that is a plastic knife. Z could be a basic catering
package that includes the utensil set Q and Item 2, which is a cake. X could be a birthday
party package that includes the basic catering package Z, as well as Item 3, which is a
balloon, and Item 5, which is a clown.
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Bill of Materials Screens

Bill of Materials consists of five tabbed screens that are used to enter, maintain, and view
BOM data. Each screen is used for specific purposes to aid in the maintenance of BOM's.

Bill of Materials (BOM)

Use this screen to create the structure of the BOM. A structure can be created from the top
down, starting with the highest level item identified in the “Item/Part” field. Items that
make up the structure are then entered into the table with all relevant data. You can also
create the structure by starting with the lowest level in the BOM, and enter the items for
that level in the table building from the bottom up.

Once you have created a BOM structure, you can use this screen to maintain the BOM
structure.

The BOM structure is displayed in a “tree” format on the left side of the screen (select the
“Tree” tab at the bottom of the display). You can select items in the tree to display the item
components that make up that item, if any.

Explosion

Use this screen to display the item components from which an item is composed. You can
display the data in two different views:

Single Explosion Shows the first level components from which an item is
composed.
Indented Explosion Shows the components at all levels from which an item

is composed.
Where Used

Use this screen to display where items are used in bills of material (BOM’s). You can display
the data in two different views:

Single Where Used Shows the items that use this component directly.

Indented Where Used Shows all the items (by level) that use this component
either directly or indirectly through other items.

Summary

Use this screen to display the item components only once, with the quantity required for the
number of units you specify. You can display the data in two different views:

Summarized Explosion Shows all of the item components from which
this item is composed.

Summarized Where Used Shows all of the items where this component is
used.
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Cost

Use this screen to display an indented explosion with individual component costs.
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Bill of Materials Screens Explained

Bill of Materials (BOM) Screen

Use this screen to create the structure of the BOM. A structure can represent a product that
is manufactured or a service.

Once you have created a BOM structure, you can use this screen to maintain the BOM
structure.

The BOM structure is displayed in a “tree” format on the left side of the screen (select the
“Trees” tab at the bottom of the display). Click any of the items in the tree to display the
item components that make up that item, if any.

Current Item Group

Field Explanation
Item/Part A unique identifier assigned to each item. It is the main

key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Type The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Description Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Unit of Measure Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

Copy To Unique identification of the Item/Part number that is

used to receive the Bill of Material during the Copy Bill of
Material function.

Component Table (Components and Reference Designator tabs)

Column Explanation
Row The line number of the row in the table.
Component Unique identification of an item that is a component of

another item on a Bill of Materials. This component
identification can be pre-defined using Item Definition
screens, but it is not a requirement that the component
be pre-defined.
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Quantity

Description

Unit of Measure

Component Type

Delete

Reference Designator

Message Line

This field is the quantity required for one unit of the
parent Item/Part.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some

examples of units of measure are "Bag", "Carton", and
“Feet".

Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

This is a checkbox to indicate you want to delete a
component from the bill of material.

Indicates where this component is used on the parent
item. For example, it can refer to a number or letter on
a diagram or it can be the name of a component on a
printed circuit board. You can enter multiple reference
designators separated by commas in this field.

Explanation

Displays information about the current status of the
screen including error messages.

Accessing the Bill of Material Screen

1. Click the plus (“+") next to “Inventory” or double-click % “Inventory” in the

“NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.

2. Click “Bill of Material”. The “Bill of Material” screen is then displayed.

3. If there is an item or part number in the “Item/Part” field, the bill of material for
that item or part number is displayed on the main screen.
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Using the Bill of Materials (BOM) Screen

Use these procedures to erase the screen, display, update, add, delete, display previous,
display next, and copy bill of material structures.

Creating a Bill of Materials (BOM)

Use this screen to create the structure of a bill of materials. A bill of materials may be
comprised of a series of items that are grouped together to create a larger item or service.
A structure can be created from the top down starting with the highest level item identified
in the “lItem/Part” field. Items that make up the product structure are then entered into the
table with all relevant data. You can also build the structure by starting with the lowest
level in the bill of materials and enter the items for that level in the table building bottom
up. For your convenience, there is a “tree” that appears on the left hand side of the BOM
screen so you can see the product structure as you build it. To view the application tree
instead, click on the tab at the bottom that reads “NavTree”.

Erasing the Screen

To erase the data from the screen click the Erase button -¢* located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying a Bill of Materials
To display a bill of materials, perform the following steps:
1. Enter an item or part number in the “ltem/Part” field.
2. Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.
3. The bill of materials is displayed on the main screen.
—or-

1. Use the Search button #4 next to the “Item/Part” field, the “Description” field to
select an item number.

2. Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.

3. The bill of materials is displayed on the main screen.
Updating an Existing Bill of Materials
To update an existing bill of materials, perform the following steps:

1. Display the bill of materials you wish to change. See “Displaying a Bill of
Materials” above.
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3.

In the Component table, change, enter, or select the desired information. To add
a component you can right click and use the Goto/Selection button B to select
an item. The “Description”, “Unit of Measure”, and “Component Type” columns
are filled in when you select an item. Component “Quantity” defaults to 1 if you
leave it blank. An item does not have to be pre-defined to be used as a
component. Because of this feature you can enter “ad hoc” components on the
bill of materials.

_or_

To delete a component from the bill of materials, click the checkbox T in the
“Delete” column of the component table.

When done, click the Save button (= located on the toolbar.

Adding a New Bill of Materials

To add a new bill of materials, perform the following steps:

1.

3.

Display the item for which you wish to build a new bill of materials. See
“Displaying a Bill of Materials” above.

In the Component table, enter or select the desired information. You can right
click the Goto/Selection button [&] to select an item. The “Description”, “Unit of
Measure”, and “Component Type” columns are filled in when you select an item.
Component “Quantity” defaults to 1 if you leave it blank. An item does not have
to be pre-defined to be used as a component. Because of this feature you can
enter “ad hoc” components on the bill of materials.

When done, click the Save button = located on the toolbar.

Deleting a Bill of Materials

To delete a bill of materials, perform the following steps:

1.

Display the bill of materials you wish to delete. See “Displaying a Bill of
Materials” above.

Click the Delete button X located on the toolbar.

Click the “Yes” button on the “Confirm Action” pop up message. If you do not
want to delete the bill of materials, click “No” on the “Confirm Action” pop up
message.

Note: Once a bill of materials is deleted, it can no longer be displayed or updated.

Displaying the Previous Bill of Materials

To display the bill of materials that precedes the bill of materials currently displayed,
perform the following steps:

1. Click the Previous button % located on the toolbar.

2. The previous bill of materials is displayed on the main screen.
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Displaying the Next Bill of Materials

To display the bill of materials that follows the bill of materials currently displayed, perform
the following steps:

1. Click the Next button * located on the toolbar.

2. The next bill of materials is displayed on the main screen.

Tip: You can use the Next button * as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .df, then
click the Next button F .

Copying a Bill of Materials

Use this procedure to copy a bill of materials from one item to another. The item to which
you are copying the bill of materials (the target item) must be defined in “lItem Definition”
before a copy can be performed.

1. Display the bill of materials you wish to copy. See “Displaying a Bill of Materials”
above.

2. Type the target item in the “Copy To” field

3. Click the Copy To button EZ Jocated on the toolbar. The bill of materials displayed
is copied to the target item.

4. If the target item already has a bill of materials you will see a pop-up that says,
“The Copy To Item already has a Bill of Materials, do you want to replace it?” If
you click “Yes”, the bill of materials for the “Copy To” item will be deleted and
replaced with the bill of materials from the item/part displayed and the screen
will display the new “Copy To” item bill of materials. If you click “No”, the
operation is cancelled.
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Explosion Screen

Use this screen to display the item components from which an item is composed. You can
display the data in two different views:

Single Explosion

Indented Explosion

Current Item Group

Field

Item/Part

Type

Description

Unit of Measure

Shows the first level/immediate components from
which an item is composed.

Shows the components at all levels from which
an item is composed.

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some
examples of units of measure are “Bag", "Carton", and
“Feet".

Component Table (Components, Description, and Reference Designator tabs)

Column
Row

Level

Component

Quantity

Explanation

The line number of the row in the table.

A number indicating the level at which the component is
found in this Bill of Material. The number zero (O) is the
end product (highest Level). There is no limit to the
number of levels. Parentheses () around the level
indicate a recursive item (an item that is used as a
component on itself either as an immediate component
or as a component of another component).

Unique identification of an item that is a component of
another item on a Bill of Materials. This component
identification is usually found on the Item/Part master,
but it is not a requirement that the component be on the
Item/Part master.

This field is the quantity required for one unit of the
parent Item/Part.
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Unit of Measure Defines how the item is counted or measured. Some
examples of units of measure are Bag", "Carton" and
"Feet".

Component Type Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

Description Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Reference Designator Indicates where this component is used on the parent
item. For example, it can refer to a number or letter on
a diagram or it can be the name of a component on a
printed circuit board. You can enter multiple reference
designators separated by commas in this field.

Message Line

Field Explanation
Message Displays information about the current status of the

screen including error messages.

Accessing the Explosion Screen

1. Click the plus (“+") next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Bill of Materials”. The “Bill of Materials” screen is then displayed.

3. If there is an item or part number in the “ltem/Part” field, the bill of materials for
that item part number is displayed on the main screen.

4. Click the “Explosion” tab at the top of the main screen.

5. If there is an item or part number in the “ltem/Part” field, the single level
explosion for that item is displayed on the main screen.
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Using the Explosion Screen

Use these procedures to erase the screen, display a bill of materials explosion for an item,
display the previous bill of materials explosion, and display the next bill of materials

explosion.

Erasing the Screen

To erase the data from the screen click the Erase button ;"f located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying a Bill of Materials Explosion

To display a bill of materials explosion, perform the following steps:

1.

2.

Enter an item or part number in the “ltem/Part” field.
Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.
The bill of materials is displayed on the main screen.

Click on either “Single Explosion” or “Indented Explosion” to view the different bill
of materials displays.

_O r_

Use the Search button # next to the “Item/Part” field, the “Description” field to
select an item number.

Double-click on the “Item/Part” you would like to display in the “Search” screen
table.

The bill of material is displayed on the main screen.

Click on either “Single Explosion” or “Indented Explosion” to view the different bill
of materials displays.

Displaying the Previous Bill of Materials Explosion

To display the bill of materials explosion that precedes the bill of materials explosion
currently displayed, perform the following steps:

1.

2.

Click the Previous button 4 located on the toolbar.
The previous bill of materials explosion is displayed on the main screen. The type

of explosion displayed (single or indented) will be the same as the last type you
displayed.
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Displaying the Next Bill of Materials Explosion

To display the bill of materials that follows the bill of materials currently displayed, perform
the following steps:

1. Click the Next button * located on the toolbar.

2. The next bill of materials explosion is displayed on the main screen. The type of
explosion displayed (single or indented) will be the same as the last type you
displayed.

Tip:  You can use the Next button * as a convenient way to locate the first record

in the database. Start by erasing the screen using the Erase button -€, then
click the Next button ¥ .

Explosion Reports
The Bill of Materials Explosion screen has the following reports available:

Bill of Materials Single Level Explosion
Basically the same information displayed when a single explosion is executed.

Bill of Materials Multiple Level Explosion
Basically the same information displayed when an indented explosion is executed.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Where Used Screen

Use this screen to display where items are used in bills of materials. You can display the

data in two different views:

Single Where Used

Indented Where Used

Current Item Group

Field

Item/Part

Type

Description

Unit of Measure

Shows the items that use this component
directly. Sometimes this is referred to as an
“implosion”.

Shows all the items (by level) that use this
component either directly or indirectly through
other items. Sometimes this is referred to as an
“indented implosion”.

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound" and
"Hour".

Component Table (Components, Description, and Reference Designator tabs)

Column
Row

Level

Item/Part

Quantity

Explanation

The line number of the row in the table.

A number indicating the level at which the component is
found in a Bill of Materials. The number zero (0) is the
end product (highest Level). There is no limit to the
number of levels.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

This field is the quantity required for one unit of the
parent Item/Part.
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Unit of Measure

Component Type

Description

Reference Designator

Message Line

Defines how the item is counted or measured. Some
examples of units of measure are Bag", "Carton" and
"Feet".

Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Indicates where this component is used on the parent
item. For example, it can refer to a number or letter on
a diagram or it can be the name of a component on a
printed circuit board. You can enter multiple reference
designators separated by commas in this field.

Explanation

Displays information about the current status of the
screen.

Accessing the Where Used Screen

1. Click the plus (“+") next to “Inventory” or double-click % “Inventory” in the

“NavTree”.

_o r_

Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.

2. Click “Bill of Materials”. The “Bill of Materials” screen is then displayed.

3. If there is an item or part number in the “ltem/Part” field, the bill of materials for
that item or part number is displayed on the main screen.

4. Click the “Where Used” tab at the top of the main screen.

5. If there is an item or part number in the “ltem/Part” field, the single where used
for that item is displayed on the main screen.
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Using the Where Used Screen

Use these procedures to erase the screen, display the where used bill of materials for an
item, display the previous where used bill of materials, and display the next where used bill
of materials.

Erasing the Screen

To erase the data from the screen click the Erase button ;"f located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying a Where Used Bill of Materials

To display a where used bill of materials, perform the following steps:
1. Enter an item or part number in the “ltem/Part” field.
2. Click the Open (Display) button & |ocated on the toolbar or hit the Enter key.
3. The where used bill of materials is displayed on the main screen.

4. Click on either “Single Where Used” or “Indented Where Used” to view the
different bill of materials displays.

_O r_

1. Use the Search button #4 next to the “Item/Part” field, the “Description” field to
select an item number.

2. Double-click on the “Item/Part” you would like to display in the “Search” screen
table.

3. The where used bill of materials is displayed on the main screen.

4. Click on either “Single Where Used” or “Indented Where Used” to view the
different bill of materials displays.

Displaying the Previous Where Used Bill of Materials

To display the where used bill of materials that precedes the where used bill of materials
currently displayed, perform the following steps:

1. Click the Previous button 1 located on the toolbar.
2. The previous where used bill of materials is displayed on the main screen. The

type of where used bill of materials displayed (single or indented) will be the
same as the last type you displayed.
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Displaying the Next Where Used Bill of Materials

To display the where used bill of materials that follows the where used bill of materials
currently displayed, perform the following steps:

1. Click the Next button ¥ located on the toolbar.

2. The next where used bill of materials is displayed on the main screen. The type of
where used bill of materials displayed (single or indented) will be the same as the
last type you displayed.

Tip:  You can use the Next button * as a convenient way to locate the first record

in the database. Start by erasing the screen using the Erase button -€, then
click the Next button ¥ .

Where Used Reports
The Bill of Materials Where Used screen has the following reports available:

Bill of Materials Single Level Where Used
Basically the same information displayed when a single where used is executed.

Bill of Materials Multiple Level Where Used
Basically the same information displayed when an indented where used is executed.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Summary Screen

Use this screen to display a summarized view of a bill of materials, with the quantity
required for the number of units you specify. Since a component can be used at multiple
levels within a bill of materials, the components are summarized by adding the quantity
from each level to a total for that component. You can display the data in two different

views:

Summarized Explosion Shows all of the item components from which

this item is composed in a summarized list.

Summarized Where Used Shows all of the items where this component is

Current Item Group

Field

Item/Part

Type

Description

Unit of Measure

Quantity

used in a summarized list.

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

This field is the quantity used to compute the total
number of a component required for the number of units
specified.

Summary Table (Components and Description tabs)

Column
Row

Component

Explanation
The line number of the row in the table.

Unique identification of an item that is a component of
another item on a Bill of Materials. This component
identification is usually found on the Item/Part master,
but it is not a requirement that the component be on the
Item/Part master. For a summarized where used, this is
the item where the component is used.
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Description Contains information describing the item/component.
This description can be as short as an abbreviation or a
long detailed description of the item/component.

Quantity This field is the total quantity of the component required
for the number of units specified.

Unit of Measure Defines how the item is counted or measured. Some
examples of units of measure are Bag", "Carton" and
"Feet".

Component Type Information indicating what type of component this is.

Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

Message Line

Field Explanation
Message Displays information about the current status of the

screen including error messages.

Accessing the Summary Screen

1. Click the plus (“+”) next to “Inventory” or double-click 2 “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Bill of Materials”. The “Bill of Materials” screen is then displayed.

3. If there is an item or part number in the “ltem/Part” field, the bill of materials for
that item part number is displayed on the main screen.

4. Click the “Summary” tab at the top of the main screen.
5. If there is an item or part number in the “ltem/Part” field, then the summarized

explosion for that item or part number displayed in the Summary table on the
main screen.
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Using the Summary Screen

Use these procedures to display the summarized bill of materials for an item, display the
previous summarized bill of materials, and display the next summarized bill of materials.

Displaying a Summarized Bill of Materials

To display a summarized bill of materials, perform the following steps:

1.

2.

3.

Enter an item or part number in the “Item/Part” field.

If desired, specify a quantity in the “Quantity” field.

For a Summarized Explosion, click the Open (Display) button & located on the
toolbar or hit the Enter key, or click “Show Summarized” located at the bottom of

the table.

For a Summarized Where Used, click “Show Summarized Where Used” located at
the bottom of the table.

_O r_

Use the Search button # next to the “Item/Part” field, the “Description” field to
select an item number.

Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.

The Summarized Explosion for that bill of materials is displayed on the main
screen.

If desired, specify a quantity in the “Quantity” field.
For a Summarized Explosion, click the Open (Display) button & located on the
toolbar or hit the Enter key, or click “Show Summarized” located at the bottom of

the table.

For a Summarized Where Used, click “Show Summarized Where Used” located at
the bottom of the table.

Displaying the Previous Summarized Bill of Materials

To display the summarized bill of materials that precedes the summarized bill of materials
currently displayed, perform the following steps:

1.

Click the Previous button 4 located on the toolbar. The type of summarized bill of
materials displayed (explosion or where used) will be the same as the last type
you displayed.

The previous summarized bill of materials is displayed on the main screen.
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Displaying the Next Summarized Bill of Materials

To display the summarized bill of materials that follows the summarized bill of materials
currently displayed, perform the following steps:

1. Click the Next button * located on the toolbar.

2. The next summarized bill of materials is displayed on the main screen. The type
of summarized bill of materials displayed (explosion or where used) will be the
same as the last type you displayed.

Tip:  You can use the Next button * as a convenient way to locate the first record

in the database. Start by erasing the screen using the Erase button -€, then
click the Next button ¥ .

Bill of Material Summary Reports
The Bill of Materials Summary screen has the following reports available:

Bill of Materials Explosion Summary Report
Basically the same information displayed when a summarized explosion is executed.

Bill of Materials Where Used Summary Report
Basically the same information displayed when a summarized where used is
executed.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Cost Screen

This screen allows you to perform an indented BOM explosion with cost. It displays the cost
for each component in the bill of materials and totals for the entire bill of materials.

The material cost is rolled up from lower level components so the material cost displayed in
the table for a component may not match the material cost entered for that component on
the Item Definition screen.

The other cost is not rolled up into the next higher level component; it is displayed as it was
entered on the Item Definition screen for each component.

“Total Material Cost” is calculated from the rolled up material cost for Level 1 components
only since lower level component material cost has already been added into the level 1
material cost.

“Total Other Cost” is calculated from all of the other costs displayed since other cost can
occur at any level of the bill and is independent of the structure.

“Total Cost” is the sum of “Total Material Cost” and “Total Other Cost”.

“Inventory Cost” is the value entered for the item on the Item Definition screen. It is the
cost that will be used to calculate the on hand value of inventory. “Total Cost” and
“Inventory Cost” should probably be the same.

If the “Total Cost” and “Inventory Cost” are vastly different, you should examine the bill of
material carefully and decide if there is an error in your bill, component costs, or the

inventory cost you entered for the item.

Current Item Group

Field Explanation
Item/Part A unique identifier assigned to each item. It is the main

key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Type The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Description Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Unit of Measure Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

Total Material Cost The sum of the cost for all the level 1 components in the

Bill of Materials.

Total Cost The sum of the Total Material Cost and the Total Other
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Total Other Cost

Inventory Cost

Cost.

The sum of the Other Cost for all of the components in
the Bill of Material.

The inventory cost from the Item Definition screen. This
value is used to calculate the total cost of on hand
inventory.

Summary Table (Components and Cost tabs)

Column

Row

Component

Description

Quantity

Unit of Measure

Component Type

Material Cost

Other Cost

Message Line

Explanation

The line number of the row in the table.

Unique identification of an item that is a component of
another item on a Bill of Materials. This component
identification is usually found on the Item/Part master,
but it is not a requirement that the component be on the
Item/Part master.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

This field is the quantity required for the number of units
specified.

Defines how the item is counted or measured. Some

examples of units of measure are Bag", "Carton" and
"Feet".

Information indicating what type of component this is.
Some examples of component types are “Assembly”,
“Industrial Supplies”, and “Tool”.

The purchasing or manufacturing cost of the component.
It is calculated from subordinate component material
cost and may not match what was entered in the
component’s Item Definition. If it does not match you
should verify the Item Definition material cost and the
subordinate components’ material costs.

Cost incurred at the component level that is not
attributed to purchasing or manufacturing. This can be

overhead, fees, etc. It is retrieved from the Item
Definition for the component.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Cost Screen

1.

Click the plus (“+™) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
Click “Bill of Materials”. The “Bill of Materials” screen is then displayed.

If there is an item or part number in the “ltem/Part” field, the bill of materials for
that item part number is displayed on the main screen.

Click the “Cost” tab at the top of the main screen.
If there is an item or part number in the “ltem/Part” field, then the costed

indented bill for that item or part is displayed in the Summary table on the main
screen.

Using the Cost Screen

Use these procedures to erase the screen, display the costed indented explosion for an
item, display the previous costed indented explosion, and display the next costed indented

explosion.

Erasing the Screen

To erase the data from the screen click the Erase button & located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying a Costed Indented Explosion

To display a costed indented explosion, perform the following steps:

1.

2.

Enter an item or part number in the “ltem/Part” field.

Click the Open (Display) button & located on the toolbar or hit the Enter key.
The costed indented explosion is displayed on the main screen.

—or-

Use the Search button @4 next to the “Item/Part” field or the “Description” field to
select an item number.

In the search screen, double-click on the “Item/Part” you would like.

The costed indented explosion is displayed on the main screen.
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Displaying the Previous Costed Indented Explosion

To display the costed indented explosion that precedes the explosion currently displayed,
perform the following steps:

1. Click the Previous button % located on the toolbar.
2. The previous costed indented explosion is displayed on the main screen.
Displaying the Next Costed Indented Explosion

To display the costed indented explosion that follows the explosion currently displayed,
perform the following steps:

1. Click the Next button * located on the toolbar.
2. The next costed indented explosion is displayed on the main screen.

Tip: You can use the Next button ¥ as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .Gf, then
click the Next button ! .

Bill of Material Cost Reports
The Bill of Materials Cost screen has the following report available:

Bill of Materials Cost Explosion Report
Basically the same information displayed on the Bill of Materials Cost screen.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Inventory Control

What is Inventory Control?

Inventory control allows you to track items from receipt through shipment for multiple
inventory stocking locations. When other TFG4000 applications are installed they work with
inventory control to maintain on hand balances automatically.

Inventory updates are accomplished by processing transactions which tell the system
everything it must know to maintain the inventory. Rather than updating the on hand
balance directly, you do the following:

1. Select the item and location you wish to change

2. Choose what kind of activity (transaction) you wish to perform — for example:
ship versus receive

3. Enter the quantity — for example if you are shipping 20 enter 20
4. Save the data

5. The system takes the information and updates the on hand balance, then logs
the transaction history

Each time an inventory transaction is executed, whether manually or automatically, a
history record is written as an audit trail.

It is very similar to the way you update your bank account balance. You do not tell the bank

what your current balance is, you tell them how much you are adding or subtracting from
the current balance. They apply your transaction and tell you what your current balance is.
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Initial Setup

TFG4000 Inventory Management is installed with certain features that can be changed. The
features are controlled with system variables. There are three system variables you need to
understand before you start using Inventory Management. See the System Variables screen
in the System Administration User Guide for more information about changing the settings
for system variables. The System Administration User Guide is available from the Windows
“Start” menu or from the “Documentation” menu within TFG4000.

Allow_Negative_Inventory (installation default is “No”) -— With this variable set to “No”, on
hand inventory balance cannot be negative. An inventory transaction that would cause the
on hand balance to go negative will be rejected as error. With this variable set to “Yes”, on
hand inventory balance can be negative. No inventory transactions will be rejected.

Inventory Cost (installation default is “Current Cost”) — With this variable set to “Current
Cost”, inventory cost is calculated using the total inventory cost entered for an item on the
Item Definition screen. When the inventory cost on the Item Definition screen is changed
the total inventory cost is recalculated using the new value. With this variable set to
“Average Cost”, inventory cost is calculated using the average cost of the item. The average
cost is calculated each time inventory is received, cycle counted, or adjusted. The average
cost is calculated as follows (using a receipt for the example):

1. Average Cost = Current Inventory Cost
The initial average cost is the same as the Inventory Cost entered on the Item
Definition screen

2. Old Value = On Hand < Average Cost
When a receipt is processed, the value before the receipt is calculated

3. Receipt Value = Receipt Quantity > Current Inventory Cost
The receipt value is calculated using the current Inventory Cost on the Item
Definition screen

4. New Value = Old Value + Receipt Value
The new value of on-hand inventory is calculated by adding the old value and the
receipt value together

5. New On-Hand = Old On-Hand + Receipt Quantity
The new on-hand inventory is calculated by adding the old on-hand and the
receipt quantity together

6. New Average Cost = New Value = New On-Hand
The new average cost is calculated by dividing the new value by the new on-hand

Inventory_Location_Verify (installation default is “No”) -- With this variable set to “Yes”, the
system requires all inventory locations be predefined. With this variable set to “No”,
inventory locations can be pre-defined, but they do not have to be pre-defined. TFG4000
provides an inventory location called “Stock” at installation time.

To set up your Inventory Locations, perform the following:

1. Click the plus sign (+) next to “System Administration”.

2. Click “Location Control”.
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3. Enter the location information in the first available row.

4. Repeat as necessary.

5. Once finished, click the Save button EI located on the toolbar.
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Using Shelf-Life for Inventory Control

TFG4000 allows you to create stocking locations based on your business needs. By planning
your location identification method, you can use the TFG4000 Location Function to both
identify the physical location and inventory lot in the same data field. The physical location
allows you to identify the actual shelf, bin, drawer, or other storage areas where the
inventory is kept. An expiration date (shelf-life) is one way to separate the inventory
logically within a specific physical location. Many products have expiration dates that
indicate when that product has reached the end of its useful life. The inventory physically
looks the same, but can be separated into many smaller units based upon the date. By
entering the expiration date when a product is received into inventory, you can identify the
product to be used before the end of its shelf-life.

When pre-defining physical stocking locations, use a naming convention that allows you to
reuse the locations with minimal confusion. Once a physical stocking location has been
defined, it cannot be removed or its name changed; however, once inventory for an item is
depleted from a location, the location will no longer be associated with that item. You will
not see “empty” locations for an item, only locations that have inventory.

There are several ways you can structure your physical stocking locations:

1. You can create a physical stocking location for each item and store all items of
that type in the same physical location. Use this method when there are no
requirements to use one particular part in that location prior to another.

2. You can create a physical stocking location with an associated expiration date
(shelf-life) for an item and store all items of that type and expiration date in the
same physical location. Use this method when you want to create specific and
discrete physical stocking locations for each expiration date.

3. You can create a single physical stocking location and use suffixes such as a slash
(/) or dash (-) followed by additional information to separate the items logically
within the physical stocking location. You can use this method when you want to
identify stock by some attribute such as color.

4. You can also add a suffix such as the slash (/) or dash (-) followed by additional
information to each physical stocking location to identify different inventory lots
that have a shelf-life. When you receive an item you can then use the expiration
date (shelf-life) to track the item. A location-lot identifier can be associated, at
any given time, with only one expiration date until all of the associated items are
used.

Each physical stocking location/inventory-lot identifier can be up to 30 characters long and
if you have the “Inventory Location Verify” parameter set to “Yes”, they must be created
prior to the receipt of inventory by using the TFG4000 Location Control screen. If the
parameter is set to “No” you can key in any location identifier.

Note: Please use caution if you are not using location verification as misspelled locations
are considered separate locations.

Once you have created your physical stocking locations, you can use the TFG4000 Inventory
Control screens to:

1. Receive an item into a specific physical location and inventory lot based on the
item identifier and, if applicable, the expiration date.
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Disburse or use inventory from stock by using the physical location/inventory lot
to determine which physical location to use.

. Adjust inventory up or down as necessary for initial balances and corrections.

Cycle count inventory (do a physical count and update the system with the
results)

. View the activity history for each item and track the usage of the item.
View inventory with expiration dates to determine which physical location for that

item to use first. The inventory is displayed with the oldest expiration date at the
top of the list.
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Inventory Control Screens

Inventory Control consists of four tabbed screens that are used to enter, maintain, and view
inventory data. Each screen is used for specific purposes to aid in the entry and
maintenance of inventory.

Inventory

Use this screen to control and track the movement of your inventory in multiple stocking
locations.

Location Inventory

Use this screen to control and track the movement of your inventory for multiple items in
one inventory stocking location.

Inventory History

Use this screen to view the movement of your inventory. You can view the adjustment,
cycle count, issuance, scrapping, return, receipt, and shipment of each item with the most
recent activity first.

Shelf-Life Summary

Use this screen to view the shelf-life information for inventory items that have expiration
dates.

Inventory Summary

Use this screen to view the total on-hand inventory for an item or for multiple items based
on selection criteria.
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Inventory Control Screens Explained

Inventory Screen

Use this screen to control and track the movement of your inventory in multiple stocking
locations. You can perform the following actions on the inventory:

Adjust (+7/-) Increments the on-hand balance if you enter a
positive Transaction Quantity, decrements if you enter a
negative quantity.

Change or correct the on-hand quantity of an item in a
specific stocking location. You can use a quantity of zero
to put a shelf-life/expiration date on an inventory
location that did not already have one without affecting
the on-hand balance.

Cycle Count (+ 7/ -) Uses the on-hand balance and the transaction
quantity entered to calculate the difference then either
increments on-hand or decrements on-hand.

Enter the quantity that was physically counted in a
location. The system will generate the appropriate
adjustment.

Issue (-) Decrements the on-hand balance.

Disburse/use inventory. Use this transaction type to
indicate you have removed inventory.

Move (-/+) Decrements the on-hand balance in the location
where the inventory is moving from and increments the
on-hand balance in the location where the inventory is
being moved to.

Move inventory from one location to another.

Receive (+) Increments the on-hand balance.
Accept an item into a stocking location.

Return (+7/ -) Increments the on-hand balance if you enter a
positive Transaction Quantity, decrements if you enter a
negative quantity.

Put inventory into a stocking location indicating it was
returned to inventory by using a positive quantity or
remove inventory from a stocking location indicating it

has been returned to the vendor by using a negative
quantity.
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Scrap (-) Decrements the on-hand balance.

Discard an inventory item. Use this transaction type to
indicate inventory that was not useable.

Ship (-) Decrements the on-hand balance.

Use this transaction type to indicate inventory has been
sold or shipped.
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Current Item Group

Field

Item/Part

Type

Description

Unit of Measure

Item Cost Total

Reserve

Total Cost

Item Percent

No Cost

Cost Method

Unit Cost

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

The total cost of all on hand inventory for an item based
on the inventory cost defined on the “Item Definition”
screen or average cost that has been calculated using
inventory cost. (The item cost total is updated each time
an inventory transaction is performed for the item.

The reserve quantity from all Reserved Job Orders for
this Item/Part. (Used only if Job Order Management is
installed)

The total cost of all on hand inventory for all items.

The percentage of the Total Cost (see above) that this
item represents.

The number of items which do not have cost data.

Indicates how total cost is determined. Current Cost
means the Inventory Cost defined on the Item Definition
screen is used. Average Cost means the average
inventory cost calculated over time is used. For more
information about Current Cost and Average Cost, see
Initial Setup on page 76.

The cost amount used to determine the Item Cost Total.
Based on the value in the Cost Method field, it will be
either the Inventory Cost defined on the Item Definition
screen, or the average cost calculated over time.
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Inventory Table (Inventory, Job Order and Shelf Life tabs)

Column
Row

Transaction Type

Transaction Quantity

Location

Onhand Quantity

Move To Location

Description

Order Number

Order Type

Expiration Date
Life Type

Message Line

Explanation

The line number of the row in the table.

Kind of transaction that is to be performed. Used only if
you are performing an inventory transaction.

The number of units that are to be processed for this
inventory transaction for this Iltem/Part. This quantity
can be negative or positive. Used only if you are
performing an inventory transaction.

Identification of the Location where inventory is stored
for this Item/Part.

The number of units that are on hand in this location for
this ltem/Part.

Identification of the Location where inventory is to be
moved if you are performing a Move transaction. This
column is displayed only if you are performing a move
transaction.

Place to enter a description of the inventory transaction
being performed. Used only if you are performing an
inventory transaction.

Place to enter an order number to which the inventory
transaction will be associated (Must be a valid order
number if Job Order Management, Sales Order
Management, or Purchasing Management is installed).
Used only if you are performing an inventory
transaction.

Type of order the order number represents (Job Order,
Sales Order, or Purchase Order). Used only if you are
performing an inventory transaction.

Date when the inventory will not be usable.

Type that indicates how the shelf life date is determined.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Inventory Control Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_o r_

Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.

2. Click “Inventory Control”. The Inventory Control screen is then displayed.

3. If there is an item or part number in the “lItem/Part” field, the inventory for that
item is displayed on the main screen.

Using the Inventory Screen

Use these procedures to display inventory for an item, update inventory for an item, display
inventory for the previous item, and display inventory for the next item.

Displaying Inventory

To view inventory for an item, perform the following steps:

1.

2.

3.

Enter an item number in the “ltem/Part” field, or use the Search button %
next to the “Item/Part” field to select an item number.

Click the Open (Display) button & located on the toolbar.

View the inventory information displayed on the screen.

Adding New Inventory

To add new inventory information, perform the following steps:

1.

Enter an item number in the “ltem/Part” field, or use the Search button %
next to the “Item/Part” field to select an item number.

Click the Open (Display) button & located on the toolbar.

Select a “Transaction Type” using the dropdown provided; either Adjust or
Receive.

Enter the quantity you want to add in the “Transaction Quantity” column.
Notice the “OnHand Quantity” column now has the quantity you entered.

Enter or select a storage location in the “Location” column.

Type in text describing the transaction you are performing in the “Transaction
Description” column if desired.

If you have an order that must be associated with this transaction click the

“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.
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If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Click the Save button [ located on the toolbar. The on-hand quantity will be
calculated and the transaction you executed can be viewed with the Inventory
History screen.

Updating Inventory — Single Transaction for a Location

To update inventory information using an existing row, perform the following steps:

1.

10.

Enter an item number in the “ltem/Part” field, or use the Search button &4
next to the “Item/Part” field to select an item number.

Click the Open (Display) button & located on the toolbar.

In the row for the location you want to update, select a “Transaction Type”
using the dropdown provided.

Enter the quantity you want to add or subtract in the “Transaction Quantity”
column. Notice the “OnHand Quantity” column has been adjusted based on
the quantity you entered.

If you are performing a Move transaction, enter or select the location where
you want the inventory moved in the “Move To Location” column. Note: The
“Move To Location” column is not normally displayed. It appears when you
select Move as the “Transaction Type”.

Type in text describing the transaction you are performing in the “Transaction
Description” column if desired.

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Repeat steps 3 through 8 for each location you want to update.

Click the Save button [ located on the toolbar. The on hand quantity for
each location you chose is updated. Each location update is a single
transaction and the transaction details can be viewed with the Inventory
History screen.

Updating Inventory — Multiple Transactions for a Location

To update inventory information using a new row, perform the following steps:

1.

2.

Enter an item number in the “ltem/Part” field, or use the Search button %
next to the “ltem/Part” field to select an item number.

Click the Open (Display) button & located on the toolbar.
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3. In a new row, select a “Transaction Type” using the dropdown provided.

4. Enter the quantity you want to add or subtract in the “Transaction Quantity”
column. Notice the “OnHand Quantity” column now has the quantity you
entered and it indicates if the quantity will be added or subtracted. Negative
quantities are subtracted, positive quantities are added.

5. Enter or select a storage location in the “Location” column. Note: Please
verify the location you use matches one that already has inventory for the
item. If it does not match it will be considered a new location and it will be
added.

6. If you are performing a Move transaction, enter or select the location where
you want the inventory moved in the “Move To Location” column. Note: The
“Move To Location” column is not normally displayed. It appears when you
select Move as the “Transaction Type”.

7. Type in text describing the transaction you are performing in the “Transaction
Description” column if desired.

8. If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

9. If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

10. Repeat steps 3 through 9 for each transaction you want to perform.

11. Click the Save button & located on the toolbar. The on-hand quantity
affected by each transaction is updated and details of each transaction can be
viewed with the Inventory History screen.

Displaying Inventory for the Previous Item

To display inventory for the item that precedes the item currently displayed, perform the
following steps:

1. Click the Previous button 4 located on the toolbar.

2. Inventory for the previous item is displayed on the main screen.
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Displaying Inventory for the Next Item

To display inventory for the item that follows the item currently displayed, perform the
following steps:

1. Click the Next button * located on the toolbar.

2. Inventory for the next item is displayed on the main screen.

Tip: You can use the Next button * as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .df, then

click the Next button ¥ .

Inventory Control Reports
The Inventory Control screen has the following reports available:

Inventory Cost Report
All items with inventory showing on-hand balance and cost. Sorted by item number.

Inventory Cost Report by Location
All items with inventory showing on-hand balance and cost. Sorted by inventory

location.

Inventory Cost Report by Product Group
All items with inventory showing on-hand balance and cost. Sorted by item product

group.

Inventory Cycle Count
Enter or select an item to start and an item to end, or leave the start and end items

blank for all items. Enter a number in the “Number of Rows to Display” field to limit
the size of the report or make this number very large to make sure you see all items
that could be listed based on the start and end items used. Click the “Refresh”
button to run a report that can be used for doing a physical inventory. There is a
place for entering the number of items actually counted in a particular location.
Those numbers can be used to perform cycle count transactions.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.

88



Location Inventory Screen

Use this screen to control and track the movement of your inventory for multiple items in
one stocking locations. You can perform the following actions on the inventory:

Adjust (+7/-) Increments the on-hand balance if you enter a
positive Transaction Quantity, decrements if you enter a
negative quantity.

Change or correct the on-hand quantity of an item in a
specific stocking location. You can use a quantity of zero
to put a shelf-life/expiration date on an inventory
location that did not already have one without affecting
the on-hand balance.

Cycle Count (+ 7/ -) Uses the on-hand balance and the transaction
quantity entered to calculate the difference then either
increments on-hand or decrements on-hand.

Enter the quantity that was physically counted in a
location. The system will generate the appropriate
adjustment.

Issue (-) Decrements the on-hand balance.

Disburse/use inventory. Use this transaction type to
indicate you have removed inventory.

Move (-/+) Decrements the on-hand balance in the location
where the inventory is moving from and increments the
on-hand balance in the location where the inventory is
being moved to.

Move inventory from one location to another.

Receive (+) Increments the on-hand balance.
Accept an item into a stocking location.

Return (+/ -) Increments the on-hand balance if you enter a
positive Transaction Quantity, decrements if you enter a
negative quantity.

Put inventory into a stocking location indicating it was
returned to inventory by using a positive quantity or
remove inventory from a stocking location indicating it
has been returned to the vendor by using a negative
quantity.

Scrap (-) Decrements the on-hand balance.

Discard an inventory item. Use this transaction type to
indicate inventory that was not useable.
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Ship

Current Item Group

Field

Location

Type

Status

Inventory Table (Inventory tab)
Column
Row

Transaction Type

Transaction Quantity

Item/Part

Onhand Quantity

Onhand Quan Orig

Item Description

(-) Decrements the on-hand balance.

Use this transaction type to indicate inventory has been
sold or shipped.

Explanation

Inventory location name.

The type helps further define a location by giving it a
classification. Some examples of types are:
"Warehouse", "Finished", "WIP" (Work In Process)

The current status of the location, for example “Active”,

“Inactive”, “Quarantine”.

Explanation

The line number of the row in the table.

Kind of transaction that is to be performed. Used only if
you are performing an inventory transaction.

The number of units that are to be processed for this
inventory transaction for this Item/Part. This quantity
can be negative or positive. Used only if you are
performing an inventory transaction.

Identification of an Item/Part stored in this location.

The number of units that are on hand in this location for
this Item/Part.

The number of units that were on hand in this location
for this Item/Part before the transaction was begun.

Contains information describing the item. This

description can be as short as an abbreviation or a long
detailed description of the item.
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Inventory Table (Move Location tab)

Column
Row

Transaction Type

Transaction Quantity

Item/Part

Move To Location

Inventory Table (Order tab)

Column
Row

Transaction Type

Transaction Quantity

Item/Part

Order Number

Order Type

Explanation

The line number of the row in the table.

Kind of transaction that is to be performed. Used only if
you are performing an inventory transaction.

The number of units that are to be processed for this
inventory transaction for this Iltem/Part. This quantity
can be negative or positive. Used only if you are
performing an inventory transaction.

Identification of an Item/Part stored in this location.

Identification of the Location where inventory is to be
moved if you are performing a Move transaction. This
column is used only if you are performing a move
transaction.

Explanation

The line number of the row in the table.

Kind of transaction that is to be performed. Used only if
you are performing an inventory transaction.

The number of units that are to be processed for this
inventory transaction for this Item/Part. This quantity
can be negative or positive. Used only if you are
performing an inventory transaction.

Identification of an Item/Part stored in this location.

Place to enter an order number to which the inventory
transaction will be associated (Must be a valid order
number if Job Order Management, Sales Order
Management, or Purchasing Management is installed).
Used only if you are performing an inventory
transaction.

Type of order the order number represents (Job Order,
Sales Order, Purchase Order or Preventive Maintenance
Order). Used only if you are performing an inventory
transaction.

91



Inventory Table (Shelf Life tab)

Column
Row

Transaction Type

Transaction Quantity

Item/Part
Expiration Date

Life Type

Inventory Table (Description tab)

Column
Row

Transaction Type

Transaction Quantity

Item/Part

Transaction Description

MSP Process

Message Line

Explanation

The line number of the row in the table.

Kind of transaction that is to be performed. Used only if
you are performing an inventory transaction.

The number of units that are to be processed for this
inventory transaction for this Iltem/Part. This quantity
can be negative or positive. Used only if you are
performing an inventory transaction.

Identification of an Item/Part stored in this location.

Date when the inventory will not be usable.

Type that indicates how the shelf life date is determined.

Explanation

The line number of the row in the table.

Kind of transaction that is to be performed. Used only if
you are performing an inventory transaction.

The number of units that are to be processed for this
inventory transaction for this Item/Part. This quantity
can be negative or positive. Used only if you are
performing an inventory transaction.

Identification of an Item/Part stored in this location.

Place to enter a description of the inventory transaction
being performed. Used only if you are performing an
inventory transaction.

Indicates if the inventory location is used for material
scheduling.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Location Inventory Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Item Inventory”. The Item Inventory screen is displayed.

3. If there is an item in the “lItem/Part” field, the inventory for that item is displayed
on the main screen.

4. Click the “Location Inventory” tab at the top of the main screen.

5. If there is a location in the “Location” field, the inventory for that location is
displayed on the main screen.

Using the Location Inventory Screen

Use these procedures to display inventory for a location, update inventory in a location,
display inventory for the previous location, and display inventory for the next location.

Displaying Inventory
To view inventory for a location, perform the following steps:

1. Enter a location in the “Location” field, or use the Search button % next to
the “Location” field to select a location.

2. Click the Open (Display) button & located on the toolbar.
3. View the inventory information displayed on the screen.
Adding New Inventory
To add new inventory information, perform the following steps:

1. Enter a location in the “Location” field, or use the Search button &4 next to
the “Location” field to select a location.

2. Click the Open (Display) button i located on the toolbar.

3. Select a “Transaction Type” using the dropdown provided; Adjust, Receive,
or Cycle Count are recommended for entering new inventory.

4. Enter the quantity you want to add in the “Transaction Quantity” column.
Notice the “OnHand Quantity” column now has the quantity you entered.

5. Enter or select an item in the “ltem/Part” column.
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2

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Click the “Description” tab and type in text describing the transaction you are
performing in the “Transaction Description” column if desired.

Click the Save button [ located on the toolbar. The on-hand quantity will be
calculated and the transaction you executed can be viewed with the Inventory
History screen.

Updating Inventory — Single Transaction for an Item

To update inventory information using an existing row, perform the following steps:

1.

10.

Enter a location in the “Location” field, or use the Search button #% next to
the “Location” field to select a location.

Click the Open (Display) button & located on the toolbar.

In the row for the item you want to update, select a “Transaction Type” using
the dropdown provided.

Enter the quantity you want to add or subtract in the “Transaction Quantity”
column. Notice the “OnHand Quantity” column has been adjusted based on
the quantity you entered.

If you are performing a Move transaction, click the “Move Location” tab, then
enter or select the location where you want the inventory moved in the “Move
To Location” column

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Click the “Description” tab and type in text describing the transaction you are
performing in the “Transaction Description” column if desired.

Repeat steps 3 through 8 for each item you want to update.
Click the Save button ld located on the toolbar. The on hand quantity for

each item you chose is updated. Each item update is a single transaction and
the transaction details can be viewed with the Inventory History screen.
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Updating Inventory — Multiple Transactions for an item

To update inventory information using a new row, perform the following steps:

1.

10.

11.

Enter a location in the “Location” field, or use the Search button #% next to
the “Location” field to select a location.

Click the Open (Display) button & |ocated on the toolbar.
In a new row, select a “Transaction Type” using the dropdown provided.

Enter the quantity you want to add or subtract in the “Transaction Quantity”
column. Notice the “OnHand Quantity” column now has the quantity you
entered and it indicates if the quantity will be added or subtracted. Negative
quantities are subtracted, positive quantities are added.

Enter or select an item in the “lItem/Part” column. Note: Please verify the
item you use matches one that already has inventory in this location. If it
does not match it will be considered a new item for the location and it will be
added.

If you are performing a Move transaction, click the “Move Location” tab, then
enter or select the location where you want the inventory moved in the “Move
To Location” column

If you have an order that must be associated with this transaction click the
“Order” tab, then enter the order number in the “Order Number” column and
select an order type using the dropdown in the “Order Type” column.

If the inventory must have an expiration date click the “Shelf Life” tab, then
enter or select a date in the “Expiration Date” column.

Click the “Description” tab and type in text describing the transaction you are
performing in the “Transaction Description” column if desired.

Repeat steps 3 through 9 for each transaction you want to perform.

Click the Save button & located on the toolbar. The on-hand quantity
affected by each transaction is updated and details of each transaction can be
viewed with the Inventory History screen.

Displaying Inventory for the Previous Location

To display inventory for the location that precedes the location currently displayed, perform
the following steps:

1. Click the Previous button 4 located on the toolbar.

2. Inventory for the previous location is displayed on the main screen.
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Displaying Inventory for the Next Location

To display inventory for the location that follows the location currently displayed, perform
the following steps:

1. Click the Next button ¥ located on the toolbar.
2. Inventory for the next location is displayed on the main screen.

You can use the Next button * as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .df, then

click the Next button ¥ .

Tip:

Location Inventory Reports

The Location Inventory screen has the following reports available:

Inventory by Location Report
All items with inventory showing on-hand balance. Sorted by inventory location.

Inventory Cost by Location Report
All items with inventory showing on-hand balance and cost. Sorted by inventory

location.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Inventory History Screen

Use this screen to view the movement of your inventory. You can view the adjustment,
issuance, scrapping, return, receipt, and shipment of each item, with the most recent
activity at the top of the list in the table.

Current Item Group

Field Explanation
Item/Part A unique identifier assigned to each item. It is the main

key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Transaction Information indicating the type of inventory transaction
that was performed (Adjust, Cycle Count, Issue, Scrap,
Return, Receive, Ship).

Transaction Description Enter a full or partial description to search data by
description. Use the percent sign (%) for wildcards.

Start Date The start date on which to start the retrieval of the data.

End Date The end date on which to stop the retrieval of the data.

Select Location Enter a full or partial location name to search data by
inventory location. Use the percent sign (%) for
wildcards.

Number of Rows to Display Controls the number of database rows to retrieve during

the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.
Use the selection criteria to help control the number of
rows retrieved.

Transaction Table (Transaction, Description, Shelf Life, and User tabs)

Column Explanation
Row The line number of the row in the table.
Item/Part A unique identifier assigned to each item. It is the main

key for all other item data. The identifier can be a
number, a name, or some combination of numbers and

characters.

Time Stamp Identification of the Date and Time that this transaction
was recorded for this row. This column is in descending
order.

Location Identification of the Location where inventory is stored

for this Item/Part.
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Transaction

Quantity

Order Type

Order Number

Description

Expiration Date

Life Type

User ID

Message Line

Field

Message

Information indicating the Type of inventory transaction
that was performed. Some examples of types are:
"Adjust”, "Receive" , and "Ship".

The number of units that were processed for this
inventory transaction for this Item/Part.

Type of order for which the transaction was executed,
e.g. Job Order, Ship Order, Customer Order, etc. if
applicable.

Indicates the order that created this inventory
transaction if applicable.

The transaction description can be used for comments or
any other additional information about an inventory
transaction.

Expiration date of when the inventory will not be usable.

Type that indicates how the shelf life date is determined.

Identification of the person who performed the inventory
transaction.

Explanation

Displays information about the current status of the
screen.

Accessing the Inventory History Screen

1. Click the plus (“+") next to “Inventory” or double-click % “Inventory” in the

“NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.

2. Click “Inventory Control”. The Inventory Control screen is then displayed.

3. If there is an item or part number in the “lItem/Part” field, the inventory for that
item is displayed on the main screen.

4. Click the “Inventory History” tab at the top of the main screen.

5. If there is an item or part number in the “Item/Part” field, the inventory history
for that item is displayed on the main screen.
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Using the Inventory History Screen

Displaying Inventory Transaction History

To view inventory history, perform the following steps (Steps 1 through 5 are optional):

1.

Enter all or part of an item number in the “lItem/Part” field, or use the Search
button # next to the “Item/Part” field to select an item number. Leave this
field blank to history for all items.

Enter all or part of a transaction description in the “Transaction Description”
field in the Current Item area of the screen or leave this field blank.

Select a transaction type in the “Transaction” field in the Current Item area or
leave this field blank to see all transaction types.

Enter or a select a stocking location in the “Location” field in the Current Item
area of the screen or leave this field blank to see all locations.

Enter a Start Date and End Date to specify the range to display in Inventory

History. The date range defaults to 30 days before today’s date in the Start
Date and today’s date in the End Date.

Click the Open (Display) button & located on the toolbar.
View the Inventory History information displayed on the screen.
If the record you are looking for is not displayed in the table, either increase

the “Number of Rows to Display” or change the selection criteria, particularly
the Start and End dates.
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Inventory History Reports
The Inventory History screen has the following reports available:

Inventory Transaction History by Date
Inventory history for all items sorted by transaction date in descending order (most
current date first).

Inventory Transaction History by Item

Inventory history for selected items sorted by item number in ascending order, then
transaction date in descending order. In addition there is field for selecting a
transaction type to further refine your search.

Inventory Transaction History by Description

Inventory history for all items sorted by item number in ascending order. In addition
there is a field for entering all or part of a transaction description and a field for
selecting a transaction type to further refine your search.

Inventory Transaction History by Location

Inventory history for all items sorted by transaction date in descending order, then
location name in ascending order. In addition there is a field where you can enter or
select a location name and a field for selecting a transaction type to further refine
your search.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Shelf-Life Summary Screen

Use this screen to view the shelf-life information for inventory items that have expiration

dates.
Selection Criteria Group

Field

Iltem/Part

Number of Rows to Display

Summary Table
Column

Row

Expiration Date

Item/Part

Location

Onhand Quantity

Life Type

Message Line

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Controls the number of database rows to retrieve during
the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.

Use the selection criteria to help control the number of
rows retrieved.

Explanation

The line number of the row in the table.

Date when the inventory will not be usable.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and

characters.

Identification of the Location where inventory is stored
for this Item/Part.

The number of units that are on hand in this location for
this ltem/Part.

Type that indicates how the shelf life date is determined.

There is only one Life Type used at this time — Date:
Expiration date was entered manually.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Shelf-Life Summary Screen

1. Click the plus (“+”) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
2. Click “Inventory Control”. The Inventory Control screen is then displayed.

3. If there is an item or part number in the “lItem/Part” field, the inventory for that
item is displayed on the main screen.

4. Click the “Shelf Life Summary” tab at the top of the main screen.
5. If there is an item or part number in the “ltem/Part” field, the shelf life summary
for that item is displayed on the main screen.
Using the Shelf-Life Summary Screen
Displaying Inventory Shelf-Life Summary
To view shelf-life summary, perform the following steps (Step 1 is optional):

1. Enter all or part of an item number in the “Item/Part” field, or use the Search
button @ next to the “Item/Part” field to select an item number.

2. Click the Open (Display) button & located on the toolbar.
3. View the Shelf-life Summary information displayed on the screen.

4. If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change the selection criteria.

Shelf Life Summary Reports
The Shelf Life Summary screen has the following report available:

Shelf Life Summary List
Basically the same information displayed on the Shelf Life Summary screen.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Inventory Summary Screen

Use this screen to view the on-hand inventory for more than one item.

Selection Criteria Group

Field

Item/Part

Number of Rows to Display

Summary Table
Column
Row

Item/Part

Onhand Quantity

Reserve Quantity

Total Cost

Current Cost

_Or_

Average Cost

Last Changed

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

Controls the number of database rows to retrieve during
the query. The default value is 30. The more rows
retrieved, the longer it takes the query to complete.

Use the selection criteria to help control the number of
rows retrieved.

Explanation

The line number of the row in the table.

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The number of units that are on hand in this location for
this ltem/Part.

The reserved quantity from all Reserved Job Orders for
this item/part. (Only used if Job Order Management is
installed)

The total cost of all on-hand inventory for this item
based on value in the “Average Cost” or “Current Cost”
column.

If the column heading is “Current Cost”, this is the
Inventory Cost entered on the “ltem Definition” screen.
It is the value of the item in inventory.

If the column heading is “Average Cost”, this is the
Average Cost calculated using the Inventory Cost
entered on the “Item Definition” screen. It is the
average cost of the item over time. See Initial Setup on
page 76 for more information about Average Cost.

Last date/time this data was changed.
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Message Line

Explanation

Displays information about the current status of the
screen.

Accessing the Inventory Summary Screen

1.

Click the plus (“+) next to “Inventory” or double-click % “Inventory” in the
“NavTree”.

_Or_
Click on the “View” menu. Select “Goto Screen”, then select “Inventory”.
Click “Inventory Control”. The Inventory Control screen is then displayed.

If there is an item or part number in the “ltem/Part” field, the inventory for that
item is displayed on the main screen.

Click the “Inventory Summary” tab at the top of the main screen.

If there is an item or part number in the “lItem/Part” field, the inventory
summary for that item is displayed on the main screen.
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Using the Inventory Summary Screen
Displaying Inventory Summary
To view inventory summary, perform the following steps (Step 1 is optional):

1. Enter all or part of an item number in the “Item/Part” field, or use the Search
button @ next to the “Item/Part” field to select an item number.

2. Click the Open (Display) button i located on the toolbar.
3. View the Inventory Summary displayed on the screen.

4. If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change the selection criteria.

Inventory Summary Reports
The Inventory Summary screen has the following report available:

Inventory Summary List
Basically the same information displayed on the Inventory Summary screen.

For more information about viewing, modifying, and printing reports, see “Working with
Reports” in the “Using TFG4000” section of this manual.
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Advanced Installation

TFG4000 provides some advanced installation functionality such as: font sizes, system
variables, server start up options, BAT file options for single user and multi user modes.

Please refer to the System Administration User Guide for more information.

Documentation

TFG4000 documentation (in PDF format) is available online at www.tfg4000.com, through
the “Documentation” menu on each screen, or from the Windows “Start” menu. Simply
click “Start”, then “Programs”, then “TFG4000 V1.4", and then “Documentation”.

Note: PDF files require Adobe® Acrobat® Reader. The reader is available at
www.adobe.com free of charge.

Registration

Quick & Easy Online: After installation, you can go to our web page at www.tfg4000.com
to register the product. Click on “Register” and follow the instructions.

Suggestions

We are eager to improve TFG4000, and we urge you to tell us what you think of the
software and how it could be improved to better suit your needs. We have taken many
suggestions from our customers and incorporated them into our products. If you have
suggestions or comments, please send an e-mail to tfg4000@fredrickgroup.com. We want
to hear from you!

Services

The Fredrick Group, Inc. offers assistance in data conversion. For more information, contact
The Fredrick Group, Inc. directly by either:

E-mail Send an e-mail to tfg4000@fredrickgroup.com, with ‘Services’ in the subject line.

Phone Call 770-844-8516 between 8:30 AM - 5:00 PM ET.
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Support

Note: You must be registered in order to receive support.

Initial Installation Support

The Fredrick Group, Inc. provides free initial installation support via e-mail. Installation
support is available for 30 days, and is activated when you send your first message. You
may also receive installation support by calling, but you must pay the cost of the call.
Technicians are available on a limited basis Monday through Friday from 8:30 am to 5:00
pm Eastern time. The TFG4000 product technical support number is 770-844-8516.

Pay-As-You-Go Support

Additional fee-based support is available. You pay the cost of the call plus an additional fee.
Credit card information must be provided and confirmed before a call is accepted.
Technicians are available on a limited basis Monday through Friday from 8:30 am to 5:00
pm Eastern time. The TFG4000 product technical support number is 770-844-8516.

Contact The Fredrick Group, Inc. at tfg4000@fredrickgroup.com for more details.

Other Support Options
Other support options are available.

Contact The Fredrick Group, Inc. at tfg4000@fredrickgroup.com for more details.

Note: Support plans and fees are subject to change without notice.

TFG4000 Software Series

You can obtain the following TFG4000 applications by visiting your nearest retailer:

Inventory Management
Job Order Management
Sales Order Management
Purchasing Management

For more information go to www.tfg4000.com.

107



